ENGLISH
•Digimax V10

User's Manual

Thank you for buying a Samsung Camera.
This manual will guide you through using the camera, including capturing images, downloading images and
using the software applications. Please read this manual carefully before using your new camera.

Instructions
Use this camera in the following order

Set up the
camera driver

Before connecting the camera to a PC, via the
USB cable, you will need to set up the camera
driver. Install the camera driver that is contained in
Application software CD-ROM.(p.115)

Take a picture (p.21)

Take a picture

Insert the
USB cable

Check the
camera’s power

Check
[Removable Disk]

Insert the supplied USB cable into the PC’s USB
port and the camera’s USB connection
terminal.(p.124)

Check the camera’s power. If the power is turned
off, press the camera button to turn it on.(p.28)

Open Window s EXPLORER and search for
[Removable Disk].(p.125)

If you use a card reader to copy the images on the memory card to your PC, the images
could be damaged. When transferring the images taken with the camera to your PC, be sure
to use the supplied USB cable to connect the camera to your PC. Please note that the
manufacturer holds no responsibility for loss or damage of images on the memory card due
to the use of a card reader.
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Getting to know your camera
Thank you for buying a Samsung Digital Camera.
●Prior to using this camera, please read the user manual thoroughly.
●When you require After Sales service, please bring the camera and the cause of the camera
malfunction (such as Battery, Memory card etc.) to the A/S centre.
●Please check that the camera is operating properly prior to when you intend to use it
(e.g. for a trip or an important event) to avoid disappointment. Samsung camera takes no
responsibility for any loss or damages that may result from camera malfunction.
●Keep the manual in a safe place.
Microsoft, Windows and Windows logo are registered trademarks of Microsoft Corporation
incorporated in the United States and/or other countries.
All brand and product names appearing in this manual are registered trademarks of their
respective companies.

This manual contains instructions on using this camera that will help you to use this
camera safely and correctly. This will help prevent danger and injury to others.

DANGER
DANGER indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation, which, if not avoided,
could result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation, which, if not avoided, may
result in a minor or moderate injury.

Correct Disposal of This Product (Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate
collection systems) This marking shown on the product or its literature, indicates that
it should not be disposed with other household wastes at the end of its working life.
To prevent possible harm to the environment or human health from uncontrolled
waste disposal, please separate this from other types of wastes and recycle it responsibly to
promote the sustainable reuse of material resources. Household users should contact either the
retailer where they purchased this product, or their local government office, for details of where
and how they can take this item for environmentally safe recycling. Business users should
contact their supplier and check the terms and conditions of the purchase contract.
This product should not be mixed with other commercial wastes for disposal.
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Danger
Do not attempt to modify this camera in any way. This may result in fire, injury, electric shock
or severe damage to you or your camera. Internal inspection, maintenance and repairs
should be carried out by your dealer or Samsung Camera Service centre.
Please do not use this product in close proximity to flammable or explosive gases, as this
could increase the risk of explosion.
Should any form of liquid or a foreign object enter the camera, do not use it. Switch off the
camera, and then disconnect the power source (batteries or AC Power Adapter). You must
contact your dealer or Samsung Camera Service centre. Do not continue to use the camera
as this may cause a fire or electric shock.
Do not insert or drop metallic or inflammable foreign objects into the camera through access
points e.g. the memory card slot and battery chamber. This may cause a fire or electric
shock.
Do not operate this camera with wet hands. This could pose a risk of electric shock.

Warning
Do not use the flash in close proximity to people or animals. Positioning the flash too close to
your subject’s eyes, may cause eyesight damage.
When taking photographs, never point the lens of the camera directly into very strong light.
This may result in permanent damage to your eyesight.
For safety reasons keep this product and accessories out of reach of children or animals to
prevent accidents e.g.:
Swallowing batteries or small camera accessories. If an accident should occur, please
consult a doctor immediately.
There is the possibility of injury from the camera’s moving parts.
Batteries and camera may become hot during prolonged use and it may result in camera
malfunction. Should this be the case, allow the camera to sit idle for a few minutes to allow it
time to cool.
Do not recharge non rechargeable batteries. This may cause an explosion.
Do not leave this camera in places subject to extremely high temperatures, such as a sealed
vehicle, direct sunlight or other places of extreme variances in temperature. Exposure to
extreme temperatures may adversely affect the camera s internal components and could
cause a fire.
When in use, do not cover the camera or AC Power Adapter. This may cause heat to build up
and distort the camera body or cause a fire. Always use the camera and its accessories in a
well-ventilated area.
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Caution
Leaking, overheating, or burst batteries could result in fire or injury.
Use batteries with the correct specification for the camera.
Do not short circuit, heat or dispose of batteries in fire.
Do not insert the batteries with the reverse polarities.
Remove the batteries when not planning to use the camera for a long period of time.
Batteries may leak corrosive electrolyte and permanently damage the camera's components.
Do not fire the flash while it is in contact with hands or objects. Do not touch the flash after
using it continuously. It may cause burns.
Do not move the camera while it is switched on, if you are using the AC Power Adapter.
After use, always switch off the camera before unplugging the adapter from the wall socket.
Then make sure that any connector cords or cables to other devices are disconnected before
moving the camera. Failure to do so may damage the cords or cables and cause a fire or
electric shock.

An FCC warning
This device has been tested in accordance with the limits of a class B digital device
under item 15 of the FCC rules. These limits are designed to provide protection
against harmful interference in commercial installation. This equipment generates,
absorbs and can emit radio frequency energy. If it is not installed and used in
accordance with the instructions, it may cause harmful interference to radio
communication. There is however, no guarantee that interference will not occur in
some situations. Should any interference occur when this device is in operation,
please try one or more of the following measures.
Change the location and direction of any aerial.
Increase distance between the camera and the affected device.
Use a different socket away from the affected device.
Please contact a Samsung agent or a radio/TV engineer.
This device complies with part 15 of the FCC Rules.
Changes or modifications not expressly approved by the party responsible for
compliance could void user's authority to operate the equipment.
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System chart
Please check that you have the correct contents before using this product. To buy the optional
equipment, contact your nearest Samsung dealer or Samsung service centre.

< Included items >

Camera case Remote control

DPOF compatible
printer(see p.83)

User manual
Waranty card

Camera strap

SD memory card/ MMC
(see p.16)

AC adapter
(SAC-32, DC 3.3V 2.0A)

Rechargeable battery
(SLB-1137)

CHARGE

AC cord
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Battery charger
(SBC-L3)

Software CD
(see p.113~114)

System chart
System Requirements

For Windows

Computer
(see p.124)

PictBridge compatible
printer(see p.83)

PC with processor better than Pentium II 450MHz
(Pentium 700MHz or better is recommended)
Windows 98/ 98SE/ 2000/ ME/ XP
Minimum 64MB RAM (XP : 128MB)
200MB of available hard-disk space
(Over 1GB is recommended)
USB port
CD-ROM drive
1024x768 pixels, 16-bit colour display
compatible monitor
(24-bit colour display recommended)
DirectX 9.0 or later

For Macintosh

USB cable

AV cable

Power Mac G3 or later
Mac OS 9.2 ~ 10.3
Minimum 64MB RAM
110MB of available hard-disk space
USB port
CD-ROM drive
DivX (for the movie clip)

CAUTION
External monitor
Yellow cable – Video
White colour - Voice
(see p.100)

When you connect the camera to a
computer, printer or external monitor, you
have to use the USB/ AV cable supplied with
the camera, or the external devices can't
recognise the camera.
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Identification of features
Front & Top
Mode dial

Mode dial lamp

Shutter button

Power button

Jog dial
Speaker
Flash

Auto Focus
lamp &
Selftimer lamp

Lens
Microphone
Remote control sensor

Back
AEL/ ASM button
Camera status lamp

Zoom W button (Thumbnail)
Zoom T button
(Digital zoom)

MF button
(Album button)

Strap eyelet
LCD monitor
5-function button

USB/ AV
connection terminal
Tripod socket
Play mode button/ Print button
+,-/Delete button
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DC input connection point

Identification of features
Side/ 5-function button
Battery chamber cover

Voice Recording/
Voice memo/ UP button

FLASH/
LEFT button
Battery chamber

Battery holder
Memory card slot

SELF-TIMER/
Remote/
RIGHT button

MENU/ OK
button
Macro/ Play & Pause button/
DOWN button
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Identification of features
Self-timer lamp
Icon

Status
Blinking
Blinking

Blinking

Description
For the 2 seconds, the lamp blinks quickly at 0.25-second intervals.
- For the first 8 seconds, the lamp blinks at 1 second intervals.
- For the final 2 seconds, the lamp blinks quickly at 0.25-second intervals.
A picture will be taken after about 10 seconds and 2 seconds later a second picture
will be taken.

Camera Status Lamp
Status
Power on

Lamp

Description

Mode dial lamp /
The lamp turns on and off when the camera is ready
Camera Status Lamp to take a picture

After taking a picture Camera Status Lamp

The lamp blinks while saving the image data and
turns off when the camera is ready to take a picture

When the flash is charging Camera Status Lamp

The lamp blinks

When the USB cable is

The lamp lights up

inserted to a PC

Mode dial lamp

(LCD monitor turns off after initializing the device)

Transmitting Data with a PC Camera Status Lamp

The lamp blinks (LCD monitor turns off)

When the USB cable is inserted to a PC Camera Status Lamp

The lamp turns off

When the printer is printing Camera Status Lamp

The lamp blinks

When the AF activates

Camera Status Lamp

The lamp turns on (The camera focus on the subject)
The lamp blinks (The camera doesn't focus on the subject)

When the voice memo is recording Camera Status Lamp The lamp blinks
Mode icons
MODE

MOVIE VOICE RECORDING

AUTO PROGRAM

A

S

M

My

PLAY

Icon
SCENE
MODE
Night

Portrait

Children

Landscape

Close up

Text

Sunset

Dawn

Backlight

Fireworks

Beach & Snow

-

Icon
MODE
Icon
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Connecting to a Power Source
■You should use the rechargeable battery (SLB-1137) supplied with the camera.
■SLB-1137 rechargeable battery Specification
Model

SLB-1137

Type

Lithium Ion

Capacity

1,130mAh

Voltage

3.7V

Charging time

Approx. 170 MIN (Using the SBC-L3)

■Number of images and battery life
Still image

Movie

Battery life

Number of images

Recording time

Approx. 130 MIN

Approx. 260

Approx. 110 MIN

Based
on
the
following
shooting
conditions

Using the fully charged battery,
Auto mode
8M image size, Fine image quality
Shot to shot interval : 30Sec.
Changing the zoom position
between the Wide and the Tele ends
every 1 shot.
Using the flash every two times

Based
on
the
following
shooting
conditions

Using the fully charged battery
320X240 image size
30fps frame rate

※These figures are measured under Samsung’s standard conditions and Shooting conditions
and may vary depending on the way of user’s usage.

INFORMATION
Important information about battery usage
●When the camera is not used, turn off the camera power.
●Please remove the battery if the camera will not be used for long periods.
The battery can lose power over time and are prone to leaking if kept inside the camera.
●Low temperatures (below 0°C) can affect the performance of the battery and you may
experience reduced battery life.
●Battery will usually recover at normal temperatures.
●During extended use of the camera, the camera body may become warm.
This is perfectly normal.
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Connecting to a Power Source
Using the AC power adapter (SAC-32, DC 3.3V 2.0A, optional)
If you have access to a mains supply, using an AC
Adapter (SAC-32, DC 3.3V 2.0A) allows the camera
to be used for long periods of time. Plug the adapter
into the connection point (DC IN 3.3V) on the
camera. Remove the batteries from the camera
when using an AC adapter.

DANGER
Always turn off the power before taking the AC adapter out of the mains supply.
As with all mains powered devices, safety is important. Ensure that neither the camera
nor adapter comes into contact with water or metallic materials.
Please ensure that you use an AC adapter (3.3V 2.0A) with the correct specification for
the camera. Failure to do so may affect your warranty.
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Connecting to a Power Source
Using the batteries

: If the camera does not turn on after you have inserted batteries,
please check whether the batteries are inserted with the correct
polarity(+/-).

1. Open the battery chamber
cover by pushing in the
direction of the arrow.

2. Insert the batteries taking
note of the polarity (+ / -).

3. To close the battery
chamber cover, push it
until it clicks.

Removing the battery
1. Turn off the camera power. Open the battery chamber
cover and move the battery holder aside. The battery will
be released.
2. Take out the battery and close the battery chamber cover.

INFORMATION
When the battery chamber cover is opened, do not press the battery chamber cover by
force. This may cause the battery chamber cover modification or breakage.

■There are 4 indicators for battery condition that are displayed on the LCD monitor.
Battery indicator
Battery status

The battery is fully Low battery capacity Low battery capacity Low battery capacity
charged
(Prepare to recharge or (Prepare to recharge (Prepare to recharge
or use spare battery) or use spare battery)
use spare battery)
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Instructions on how to use the memory card
Maintenance of the memory card
Be sure to format the memory card (see p.96) if you are using a newly purchased memory for
the first time, if it contains data that the camera cannot recognise, or if it contains images
captured with a different camera.
Turn off the camera power whenever the memory card is being inserted or removed.
Repeated use of the memory card will eventually reduce the memory card’s performance.
Should this be the case, you will need to purchase a new memory card.
Wear and tear on the memory card is not covered by the Samsung warranty.
The memory card is an electronic precision device.
Do not bend, drop or subject the memory card to any heavy impact.
Do not store the memory card in an environment with strong electronic or magnetic fields,
e.g. near loud speakers or TV receivers.
Please do not use or store in an environment where there are extremes in temperature.
Do not allow the memory card to become dirty or to come into contact with any liquid.
Should this happen, clean the memory card with a soft cloth.
Please keep the memory card in its case when not in use.
During and after periods of extended use, you may notice that the memory card is warm.
This is perfectly normal.
Do not use a memory card that is used in another digital camera.
To use the memory card in this camera, format first the memory card by using this camera.
Do not use a memory card formatted by another digital camera or memory card reader.

Preserving the memory card data
If the memory card is subjected to any of the following, the recorded data may become
corrupted :
- When the memory card is used incorrectly.
- If the power is switched off or the memory card is removed while recording, deleting
(formatting) or reading.
Samsung cannot be held responsible for lost data.
It is advisable to copy important data onto other media as back-up e.g. floppy disks, hard
disks, CD etc.
If there is insufficient memory available : If you press the shutter button for the shot, a
[Card Full !] message will appear and the camera will not operate. To optimise the amount of
memory in the camera, replace the memory card or delete unnecessary images stored on
the memory.
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Instructions on how to use the memory card
INFORMATION
Don't remove the memory card when the Auto focus lamp(Green) is blinking as this may
cause damage to data in the memory card.

The camera can use SD Memory Cards and MMC (Multi Media Cards).
Please consult the enclosed manual for using the the MMC Cards.
The SD memory card has a write protect switch
that prevents image files from being deleted or
formatted.
By sliding the switch to the bottom of the SD
memory card, the data will be protected.
By sliding the switch to the top of the SD
memory card, the data protection will be
canceled. Slide the switch to the top of the SD
memory card before taking a picture.

Card
pins
Write
protect
switch

Label

[ SD(Secure Digital) memory card ]

When using a 32MB SD memory card, the specified shooting capacity will be as follows.
(These figures are intended as an indication of expected performance). These figures are
approximate as image capacities can be affected by variables such as subject matter.
Recorded image size

Still
image

Movie
clip

TIFF

S. Fine

Fine

Normal

3264X2448

1

7

13

19

30 FPS

15FPS

3072X2304

1

7

15

23

2816X2112

1

9

18

26

-

-

2592X1944

1

10

2272X1704

2

14

21

31

-

-

26

33

-

-

2048X1536

3

1600X1200

4

17

33

47

-

-

28

51

62

-

1024X768

-

11

60

106

129

-

-

640X480

22

121

139

165

-

-

640X480

-

-

-

-

About 1'32'' About 2' 30''

320X240

-

-

-

-

About 4' 15''

160X128

-

-

-

-

About 8' 30'' About 15' 30''

About 7'
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Inserting the memory card
1. Turn off the camera’s power and pull the battery chamber
cover in the direction of the arrow to open.

2. Have the front of the memory card facing toward the front of
the camera (lens) and the card pins toward the back of the
camera (LCD monitor), and then push the memory card into
the card slot until you hear a click.

3. To close, push the battery chamber cover until you hear a
click. If the memory card does not slide in smoothly, do not
attempt to insert it by force. Check the direction of insertion,
and then insert it correctly. Do not insert the memory card the
wrong way round. Doing so may damage the memory card
slot.

Removing the memory card
1. Turn the power off using the power button.
Open the battery chamber cover and press the memory
card as shown in the image and release.
2. Remove the memory card and close the battery chamber
cover.

INFORMATION
When the camera is turned on, inserting or removing the memory card makes the camera
power be turned off.
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When Using the Camera for the First Time
■ Charge the rechargeable battery fully before using the camera for the first time.
■ When the camera is turned on for the first time, a menu will be displayed to set date, time and
language in the LCD monitor. This menu will not be displayed after setting up the date, time
and language. Set up the date, time and language before using this camera.

● Setting up the date, time and date type
1. Select the [Date&Time] menu by pressing the UP/DOWN
button and press the RIGHT button.
Setup
▲
Date&Time
2. Select the desired sub menu by pressing the
Language
05 / 08 / 01
UP/ DOWN/ LEFT/ RIGHT button.
▼
13:00
RIGHT button
: selects YEAR/ MONTH/ DAY/ HOUR/
yy/mm/dd
MINUTE/ DATE TYPE
Back:◀
Set:OK
LEFT button
: Moves the cursor to the [Date&Time]
main menu if the cursor is at the first item of the date and time setup.
In all other instances, the cursor will be shifted to the left of its current
position.
UP/ DOWN button : changes the value of each item.

● Setting up the language
1. Select the [Language] menu by pressing the UP/DOWN
button and press the RIGHT button.
2. Select the desired sub menu by pressing the UP/ DOWN
button and press the OK button.

Setup
Date&Time

Language

ENGLISH
한국어
FRANÇAIS
DEUTSCH
ESPAÑOL

Back:◀

Set:OK

INFORMATION
● You can select 21 languages. These are listed below :
English, Korean, French, German, Spanish, Italian, S.Chinese, T.Chinese, Japanese,
Russian, Portuguese, Dutch, Danish, Swedish, Finnish, Thai,
BAHASA(MALAY/ INDONESIAN), Arabic, Hungarian, Czech and Polish.
● Even if the camera is restarted, the language setting will be maintained.
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LCD monitor indicator
■ The LCD monitor displays information about the shooting functions and selections.
①
②
③
④
⑤
⑳

⑥
⑦

⑲

⑧

⑱

⑨

⑰

⑩

⑯

⑪

⑫

⑬⑭

⑮

[ Image & Full Status ]

No.

Description

Icons

1

Battery

p.15

2

Recording mode

p.21~26

3

Shooting type

p.50

4

Aperture value, Shutter speed

5

Flash

p.33~35

6

Self-timer

p.36~38

7

Voice memo/ MIC. Off

p.25

8

Macro

p.32

9

Metering

p.49

10

Memory card indicator

p.18

11

AEL

p.42

12

Manual/ Continuous auto focus

p.43, 59

F2.8, 1/30s

Page

p.22~23

13

Auto focus frame

p.43

14

Camera shake warning

p.27

15

Date/ Time

16

Exposure compensation
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2005/08/01 01:00 PM

p.97
p.41

LCD monitor indicator
17

White Balance

p.40

18

ISO

p.40

19

RGB

20

Sharpness

p.51

21

Image quality

p.48

22

Image size

p.47

23
24

RGB

p.39

Number of available shots remaining

12

p.17

Remaining time (Movie clip/ Voice recording)

00:01:30/ 01:00:00

p.17

Optical/ Digital Zoom bar/ Zoom rate

p.29~30

Starting the recording mode
■ How to use the AUTO mode (

)

1. Insert the batteries (p.15). Insert the batteries taking
note of the polarity (+ / -).
2. Insert the memory card (p.18). As this camera has a
20MB internal memory, you do not need to insert the
memory card. If the memory card is not inserted, an
image will be stored in the internal memory. If the
memory card is inserted, an image will be stored on the
memory card.
3. Close the battery chamber cover.
4. Press the power button to turn on the camera.
(If the date/time that is displayed on the LCD monitor is
incorrect, reset the date/ time before taking a picture.)
5. Select the AUTO mode by rotating the mode dial.
6. Point the camera towards the subject and compose the
image by using the LCD monitor.
7. Press the shutter button to capture an image.

[ AUTO mode ]

INFORMATION
● If the auto focus frame turns to red when you press the shutter button down half way,
it means that the camera cannot focus on the subject. Should this be the case, the
camera is unable to capture an image clearly.
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Starting the recording mode
■ How to use the PROGRAM mode (
)
Selecting the automatic mode will configure the camera
with optimal settings. You can still manually configure all
functions except the aperture value and shutter speed.
Steps from 1-4 are the same as those for AUTO mode.
5. Select the PROGRAM mode by rotating the mode dial.
6. Press the menu button to configure advanced functions
such as image size (p.47), quality (p.48), metering (p.49),
continuous shooting (p.50) , picture effects (p.51) and
special effects (p.52).
7. Point the camera towards the subject and compose the
image by using the LCD monitor.
8. Press the shutter button to capture an image.

10.0

[ PROGRAM mode ]

■ How to use the APERTURE PRIORITY mode (
)
Steps from 1-4 are the same as those for AUTO mode.
5. Select the APERTURE PRIORITY mode by rotating the
mode dial.
6. Select the desired aperture value by rotating the jog dial.
7. Point the camera towards the subject and compose the
image by using the LCD monitor.
8. Press the shutter button to capture an image.
* Smaller Aperture values make the object sharp but blur
the background. Larger Aperture values make both the
object and background sharp.

10.0

[ Aperture priority mode ]
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Starting the recording mode
■ How to use the SHUTTER PRIORITY mode (
)
Steps from 1-4 are the same as those for AUTO mode.
5. Select the SHUTTER PRIORITY mode by rotating the
mode dial.
6. Select the desired shutter speed by rotating the jog dial.
7. Point the camera towards the subject and compose the
image by using the LCD monitor.
8. Press the shutter button to capture an image.
* High Shutter speeds can capture a moving object in a
still image as if the object is not moving. Low Shutter
speeds can capture a moving object with an ‘active’
effect.

[ Shutter Priority mode ]

■ How to use the MANUAL mode (
)
Steps from 1-4 are the same as those for AUTO mode.
5. Select the MANUAL mode by rotating the mode dial.
6. Press the ASM button to select the shutter speed or the
aperture value. Then select the desired shutter speed or
aperture value by rotating the jog dial.
7. Point the camera towards the subject and compose the
image by using the LCD monitor.
8. Press the shutter button to capture an image.

10.0

[ Manual mode ]
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Starting the recording mode
■ How to use the MySET mode (
)
This mode allows users to save frequently used shooting
settings for later use.
Steps from 1-4 are the same as those for AUTO mode.
5. Select the MySET mode by rotating the mode dial.
6. Press the menu button.
7. Use the Left/Right buttons to select the [Load Myset]
menu tap. Use the Up/Down buttons to select desired
MySET number.
8. Press the OK button to load the camera configuration
saved in the MySET number and close the menu
screen.
9. Point the camera towards the subject and compose the
image by using the LCD monitor.
10. Press the shutter button to capture an image.
Please see page 58 for details of the MySET shooting
mode and menus.

■ How to use the MOVIE CLIP mode (
)
Steps from 1-4 are the same as those for AUTO mode.
5. Select the MOVIE CLIP mode by rotating the mode dial.
6. The MOVIE CLIP mode icon and available recording
time will display on the LCD monitor.
7. Point the camera towards the subject and compose the
image by using the LCD monitor. Press the shutter
button and movie clips are recorded for as long as the
available recording time. Movie clips will still be recorded
if the shutter button is released.
* If you wish to stop recording, press the shutter button
again.
* Image size and type are listed below.
- Image size : 640X480, 320X240, 160X128(Selectable)
- File type : *.avi(MPEG-4)
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10.0

[ MySET mode ]

10.0

8

01:00 PM
2005/08/01

[ MOVIE CLIP mode ]

Starting the recording mode
■ Recording the movie clip without voice
You can record the movie clip without voice.
Steps from 1-3 are the same as those for MOVIE CLIP mode.
4. Press the Up button and the (
) icon will display on
the LCD monitor.
5. Press the shutter button and movie clip is recorded for
as long as the available recording time without voice.
6. To stop the recording, press the shutter button again.
■ Pausing while recording a movie clip (Successive Recording)
This camera allows you to temporarily stop during unwanted scenes, while recording a movie
clip. Using this function, you can record your favourite scenes into a movie clip without having
to create multiple movie clips.
● Using Successive Recording
Steps from 1-6 are the same as those for MOVIE CLIP
mode.
7. Point the camera towards the subject and compose the
image by using the LCD monitor. Press the shutter
button and movie clips are recorded for as long as the
available recording time. Movie clips will still be recorded
if the shutter button is released.
[Successive recording of a movie clip]
8. Press the Pause button(
) to pause recording.
9. Press the Pause button(
) again to resume the
recording.
10. If you wish to stop recording, press the shutter button again.
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Starting the recording mode
■ How to use the SCENE mode (
)
Use the menu to easily configure optimal settings for a variety of shooting situations.
These include NIGHT, PORTRAIT, CHILDREN, LANDSCAPE, CLOSE UP, TEXT
RECOGNITION, SUNSET, DAWN, BACKLIGHT, FIREWORKS and BEACH & SNOW
scenes.
Steps from 1-4 are the same as those for AUTO mode.
5. Select the SCENE mode by rotating the mode dial.
6. Press the menu button and select the [Scene] menu by
pressing the left and right button.
7. Select the desired [Scene] sub menu by pressing the UP and
DOWN buttons and press the OK button. Please see page 59
for detailed descriptions for each screen.
8. The current scene icon is displayed at the top left of the
LCD.
9. Point the camera towards the subject and compose the
image by using the LCD monitor.
10. Press the shutter button to capture an image.

[ SCENE mode ]

■ How to use the VOICE RECORDING mode (
)
1. In any mode with the exception of Movie clip mode,
select the VOICE RECORDING mode by pressing the
Voice recording button twice.
2. Press the shutter button to record a voice.
- Press the shutter button once and voice is recorded for
as long as the available recording time (Max : 1 hour)
allows. The recording time will be displayed on the
LCD monitor. Voice will still be recorded if the shutter
button is released.
- If you wish to stop recording, press the shutter button
again.
- File type : *.wav
* A distance of 40cm between you and the camera
(microphone) is the best distance to record sound.
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START:SHUTTER
[ VOICE RECORDING mode ]

Things to Watch Out for When Taking Pictures
■ Pressing the shutter button down half way.
Lightly press the shutter button to confirm focus and flash battery charge.
Press the shutter button all way down to take the picture.

[ Lightly press the shutter button ]

[ Press the shutter button ]

■ The available recording time may vary depending on shooting conditions and camera
settings.
■ When the Flash Off or Slow synchro mode is selected in a low lighting condition, the camera
shake warning indicator (
) may appear on the LCD monitor. In this case, use a tripod,
support the camera on a solid surface or change the flash mode to flash shot mode.
■ Compensated shooting against the light :
Please do not take pictures to the sunlight direction. Taking a picture against the sun may
make the picture dark. To take a picture against the sun, please use the [Backlight] in the
scene shooting mode (see page 59), fill-in flash (see page 35), spot metering(see page 49),
or exposure compensation (see page 41).
■ Avoid obstructing the lens or the flash when you capture an image.
■ Compose the image by using the LCD monitor.
■ Using the LCD monitor extensively will drain the batteries.
■ Under certain conditions the auto focus system may not perform as expected.
- When photographing a subject that has little contrast.
- If the subject is highly reflective or shiny.
- If the subject is moving at high speed.
- When there is strong reflected light, or when the background is very bright.
- When the subject matter has only horizontal lines or the subject is very narrow
(such as a stick or flagpole).
- When the surroundings are dark.
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Using the camera buttons to adjust the camera
■ The RECORDING (AUTO, PROGRAM, APERTURE PRIORITY, SHUTTER PRIORITY,
MANUAL, MySET, MOVIE CLIP, SCENE) mode function can be set up by using the camera
buttons.
POWER button
● Used for turning the camera’s power on / off.
● If there is no operation during the specified time, the
camera's power will be turned off automatically to save
battery life. Refer to page 95 for more information about the
auto power off function.

SHUTTER button/ Jog dial
● Used for taking an image or recording voice in the
RECORDING mode.
● In MOVIE CLIP mode :
Pressing the shutter button down fully starts the process for
recording a movie clip. Press the shutter button once and the
movie clip is recorded for as long as the available recording
time in the memory allows. If you wish to stop recording, press the shutter button again.
● In STILL IMAGE mode
Pressing the shutter button down halfway activates the autofocus and checks the condition of
the flash. Pressing the shutter button down fully takes the image and stores the relevant data
regarding the shot. If you select voice memo recording, the recording will start after the
camera has finished storing the image data.
● Jog dial : Set focus distance while using the manual focusing (see page 43).
Set the aperture value and shutter speed in the A/S/M shooting mode (see page 42).

ZOOM W/T button
● If the menu is not displayed, this button works as the
OPTICAL ZOOM or DIGITAL ZOOM button.
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ZOOM W/T button
● This camera has a 3X optical zoom and a 10X digital zoom function.
Using both will offer a total zoom ratio of 30X.

● TELE Zoom
Optical zoom TELE
Digital zoom TELE

: Pressing the ZOOM T button. This will zoom into the subject i.e.
the subject will appear nearer.
: When the maximum (3X) optical zoom is selected, pressing the
ZOOM T button activates the digital zoom software. Releasing
ZOOM T button stops the digital zooming at the required setting.
Once the maximum digital zoom (10X) is achieved, pressing the
ZOOM T button will have no effect.
Pressing the
ZOOM T button

[ WIDE zoom ]

● WIDE Zoom
Optical zoom WIDE

Pressing the
ZOOM T button

[ TELE zoom ]

: Pressing the ZOOM W button. This will zoom out from the subject
i.e. the subject will appear further away. Pressing the ZOOM W
button continuously will set the camera to its minimum zoom
setting i.e. the subject appears at its furthest from the camera.
Pressing the
ZOOM W button

[ TELE zoom ]

Digital zoom WIDE

Optical zoom

[ Digital zoom 5.0X ]

Pressing the
ZOOM W button

[ Optical zoom 2X ]

[ WIDE zoom ]

: When the digital zoom is in operation, pressing the ZOOM W
button will reduce the digital zooming in steps. Releasing ZOOM W
button stops digital zooming. Pressing the ZOOM W button will
reduce the digital zoom and then it will continue to reduce the
optical zoom until the minimum setting is reached.
Pressing the
ZOOM W button

Digital zoom

[ Digital zoom 5.0X ]

Pressing the
ZOOM W button

[ TELE zoom ]

[ WIDE zoom ]
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ZOOM W/T button
INFORMATION
● To use the digital zoom the LCD monitor has to be turned on.
● Images taken using the digital zoom may take a little longer for the camera to process.
Allow time for this to take place.
● The digital zoom cannot be used in movie clip shots.
● If the movie clip is being recorded, the zoom operation cannot be activated.
● You may notice a decrease in image quality when using the digital zoom.
● To view more clear digital zoom image, press the shutter button halfway at the maximum
(3X) optical zoom position and press the zoom T button again.
● The digital zoom can’t be activated in the [Nightscene], [Children], [Close up], [Text],
[Fireworks] scene modes and when you select TIFF image quality.
● Take care not to touch the lens to avoid taking an unclear image and possibly causing
camera malfunction. If the image is dim, turn the camera power off and on again to modify
the lens position.
● Take care not to press the lens as this may cause a camera malfunction.
● When the camera is turned on, take care not to touch the camera's moving lens parts as
this may cause the resulting image to be dim and unclear.
● Take care not to touch the lens during zoom operation as this may cause damage.
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Voice recording(

)/ Voice memo(

)/ UP button

■ While the menu is showing, press the UP button to move up the submenu cursor. When the
menu is not displayed on the LCD monitor, the UP button operates as the voice recording or
voice memo ( ) button. You can add your voice-over to a stored still image. Refer to page
26 for more information about the voice recording.
● Recording a voice memo
1. Rotate the MODE DIAL to select a RECORDING mode with the exception of MOVIE CLIP
mode.
2. Press the VOICE MEMO (
) button. If the voice memo indicator is displayed on the
LCD monitor, the setting is completed.

[Preparing for Voice Memo]

[Recording Voice Memo]

3. Press the shutter button and take a picture. The picture is stored on the memory card.
4. Voice memo will be recorded for ten seconds from the moment the picture is stored.
In the middle of the sound recording, pressing the shutter button will stop the voice memo.

INFORMATION
● A distance of 40cm between you and the camera (microphone) is the best distance to
record sound.
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Macro(

)/ Down button (Focusing)

■ While the menu is showing, press the DOWN button to move from the main menu to a
submenu, or to move down the submenu cursor.
■ When the menu is not showing, you can use the MACRO/ DOWN button to take macro
pictures (within the distance range of 4-80 cm).
Pressing the macro
button

[ Auto focus ]

[ Auto macro ]

● Types of focus modes and focus ranges

Unit : cm

Macro

Auto

Auto macro

Focus type

Focus range

WIDE

TELE

WIDE

TELE

WIDE

TELE

80 ~ ∞

80 ~ ∞

4 ~ 80

25 ~ 80

4~∞

25 ~ ∞

INFORMATION
● When the macro mode is selected, it is possible that camera shake will occur. If this is the
case, use a tripod to eliminate this.
● When you take a picture within 20cm(MACRO focus), select the FLASH OFF mode.
● In the AUTO mode, the Auto macro will be selected by pressing the macro button.

■Available focusing method, by recording mode
(O:Selectable, X:Not selectable, ∞:Infinity focus range)
Mode
Auto

O

O

O

O

O

O

O

O

Macro

X

O

O

O

O

O

O

X

Auto macro

O

X

X

X

X

X

X

X

Mode
Auto

O

O

∞

X

X

∞

∞

O

∞

O

Macro

X

X

X

O

O

X

X

X

X

X

Auto macro

X

X

X

X

X

X

X

X

X

X
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Focus lock
■ To focus on the subject positioned outside of the centre, use the focus lock function.
● Using the Focus Lock
1. Ensure the subject in the centre of the autofocus frame.
2. Press the SHUTTER button halfway. When the green auto lights up, it means the camera
is focused on the subject. Be careful not to press the SHUTTER button all the way down to
avoid taking an unwanted pictured.
3. With the SHUTTER button still pressed down only halfway, move the camera to
recompose your picture as desired, and then press the SHUTTER button completely to
take the picture. If you release your finger from the SHUTTER button, the focus lock
function will be cancelled.

1. The image to be
captured

FLASH(

2. Press the SHUTTER
button halfway and
focus on the subject

3. Recompose the
picture and fully
depress the
SHUTTER button

)/ LEFT button

■ When the menu is displayed on the LCD monitor,
10.0
pressing the LEFT button makes the cursor shift to the left
tab.
■ When the menu is not displayed on the LCD monitor, the
LEFT button operates as the FLASH (
) button.
● Selecting the flash mode
1. Rotate the MODE DIAL to select a RECORDING mode
[ Selecting the Auto flash ]
with the exception of MOVIE CLIP and VOICE
RECORDING modes.
2. Press the Flash button until the desired flash mode indicator displays on the LCD monitor.
3. A flash mode indicator will be displayed on the LCD monitor. Use the correct flash to suit
the environment.
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FLASH(

)/ LEFT button

● Flash range
Unit : m

AUTOFOCUS

MACRO

AUTO MACRO

ISO
AUTO

WIDE

TELE

WIDE

TELE

WIDE

TELE

0.8~3.0

0.8~2.0

0.2~0.8

0.25~0.8

0.2~3.0

0.25~2.0

INFORMATION
● When you press the shutter button after selecting the Auto, Fill in, Slow synchro flash,
the flash will fire to check the shooting conditions like the subject’s distance and intensity
of the flash. Do not move until the second flash fires.
● Using the flash frequently will reduce the life of the batteries.
● Under normal operating conditions the charging time for the flash is normally within 7
seconds. If the batteries are weak, the charging time will be longer.
● During the continuous shot, movie clip mode, the flash function will not operate.
● Take photographs within the flash range.
● The image quality is not guaranteed if the subject is too close or highly reflective.
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FLASH(

)/ LEFT button

● Flash mode indicator
Icon

Flash mode

Description

Auto flash

If the subject or background is dark, the camera flash will operate
automatically.

Auto &
Red eye
reduction

If a subject or background is dark, the camera flash will work
automatically and will reduce the red-eye effect by using the red-eye
reduction function.

Fill in flash

The flash fires regardless of available light.
The intensity of the flash will be controlled, according to the
prevailing conditions. The brighter the background or subject is, the
less intense the flash will be.

Slow synchro

The flash will operate in conjunction with a slow shutter speed in
order to obtain the correct exposure. We recommend using a tripod
for this function. When you take an image in a condition with poor
light, the camera shake warning indicator (
) will display on the
LCD monitor.

Flash off

The flash does not fire. Select this mode when capturing images in a
place or situation where flash photography is prohibited. When you
capture an image in a poorly lit condition, the camera shake warning
indicator (
) will display on the LCD monitor.

● Available flash mode, by recording mode

X

O

X

X

X

O

X

X

X

X

X

X

X

X

X

X

O

O

O

X

X

X

O

X

O

O

X

X

X

X

X

X

X

X

X

O

O

O

O

O

X

X

X

X

X

X

X

X

O

X

X

X

O

O

X

X

O

O

X

X

X

X

X

X

X

X

X

X

O

O

O

O

O

O

O

O

O

O

O

O

O

O

X

O

X
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Self-timer(

)/ Remote (

)/ Right button

■ When the menu is displayed on the LCD monitor, pressing the Right button makes the cursor
shift to the right tab. The right button can also be used to move to a sub menu to select a
different setting.
■ When the menu is not displayed on the LCD monitor, the RIGHT button operates as the Selftimer (
) and Remote (
) button. This function is used when the photographer would
also like to be in the image.
● Using the self-timer and remote control.
1. Rotate the mode dial to the RECORDING mode.
2. Press the SELF-TIMER button until the desired mode indicator displays on the LCD
monitor. A self-timer icon or remote control icon appears on the LCD monitor.
10.0

[Selecting the 2 SEC self-timer]

[Selecting the remote control]

- Selecting a self-timer

: When you press the SHUTTER button, the picture will be
taken after the specified time has elapsed and the self-timer
function will be canceled.
- Selecting a remote mode : Pressing the shutter button of remote control will allow an
interval of 2 seconds before the image is taken. In the remote
mode, the shutter button of the camera can’t be activated. After
taking a picture, the remote mode will be maintained. But,
pressing the power button, rotating the mode dial, pressing the
play mode button and pressing the self-timer button will cancel
the remote mode.

● Description of Self-timer/Remote mode
Icon

Mode
2s
10s
Double
Remote
mode
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Description
Pressing the shutter button will allow an interval of 2 seconds
before the image is taken.
Pressing the shutter button will allow an interval of 10 seconds
before the image is taken.
A picture will be taken after about 10 seconds and 2 seconds
later a second picture will be taken.
You can take a picture by remote control instead of using the
shutter button of the camera.

Self-timer(

)/ Remote (

)/ Right button

● Self-timer/ remote mode setting
Mode dial

Setting (

marked camera working mode is the default setting.)

AUTO
PROGRAM
A/S/M, MySET

Off → 2s self-timer → 10s self-timer
→ Double self-timer→ Remote

SCENE
MOVIE CLIP

Off → 10s self-timer → Remote

INFORMATION
● When taking a picture using the self-timer, the self-timer lamp works as follows:
2 second self-timer setting : The self-timer lamp blinks at 0.25 second interval for 2
seconds.
10 second self-timer setting : The self-timer lamp blinks at 1 second interval for the first 8
seconds. It blinks at 0.25 second interval for the remaining
2 seconds.
● If you operate the Mode dial and Self-timer button during the self-timer operation, the selftimer function is canceled.
● Use a tripod to prevent the camera from shaking.
● In Movie Clip mode, only the 10s self-timer and remote will work.

● Remote control range
When you take a picture by using the remote control, refer
to the illustrations shown alongside about the remote
control range.

[ Shutter button on the
remote control ]
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Self-timer(

)/ Remote (

)/ Right button

● Replacing batteries for the remote control
Make sure the + polarity is toward the top and the - polarity is toward the bottom while
installing batteries for the remote control. Replace batteries for the remote control in the local
service centre. Use the CR 2025 3V batteries.

MENU/ OK button
■ If the menu is displayed, use the 5-Function buttons to change the data values and for your
changes to be accepted
■ If the menu is not displayed, press the MENU/OK button to display a menu for the current
camera mode on the LCD monitor. Press the button again to return to the previous state.
Pressing
the MENU
button

Size

3264X2448
3072 X 2304
2816 X 2112
2592 X 1944
2272 X 1704
2048 X 1536

[ Menu off ]
[ Menu on ]

- There is no menu for VOICE RECORDING mode.
- The menu screen may not show on the LCD when another button is pressed or image data
is being processed. (The camera status lamp will blink)
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+/- button
■ You can use the +/- button to adjust the values for the RGB, ISO, white balance and
exposure compensation.
Main menu

Sub menu

RGB

R (Red), G (Green), B (Blue)

ISO

AUTO, 50, 100, 200, 400

Available camera mode

AUTO, DAYLIGHT, CLOUDY, FLUORESCENT H,
WHITE BALANCE
FLUORESCENT L, TUNGSTEN, CUSTOM.

Exposure compensation

-2.0~0.0~+2.0(1/3EV steps)

■ RGB : Allows the user to adjust the R (Red), G (Green), and B (Blue) values of the images to
be captured.
● Setting RGB Values
1. Press the +/- button, and then use the UP and DOWN
buttons to select the RGB icon (
).
The RGB menu bar will appear as shown.
2. Use the UP/ DOWN/ LEFT and RIGHT buttons to select
the desired RGB value.
- Up/Down Button: Navigates between R, G, and B
icons.
- Left/Right Button: Changes value of each icon.
3. When you press the +/- button again, the value you set will be saved and RGB setup
mode will end.

9

8
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+/- button
■ ISO: You can select the ISO sensitivity when taking pictures.
The speed or specific light-sensitivity of a camera is rated by ISO numbers.
● Selecting an ISO Sensitivity
1. Press the +/- button, and then use the UP and DOWN
buttons to select the ISO icon(
). The ISO menu bar
will appear as shown.
2. Use the LEFT and RIGHT buttons to select the desired
ISO sensitivity value.
- AUTO : The camera's sensitivity is automatically
changed by variables such as lighting value or subject brightness.
- 50, 100, 200, 400 : You can increase the shutter speed while the same amount of light is
present, by increasing the ISO sensitivity. However, the image may be saturated in high
luminance. The higher the ISO value, the higher the camera’s sensitivity to light is and
therefore the greater its capacity to take pictures in dark conditions. However, the noise
level in the image will increase as the ISO value increases, making the image appear
coarse.
3. When you press the +/- button again, the value you set will be saved and ISO setup mode
will end.
■ White balance : The white balance control allows you to adjust the colours to appear more
natural looking.
● Selecting a White Balance
1. Press the +/- button, and then use the UP and DOWN
buttons to select the white balance icon (
).
The white balance menu bar will appear as shown.
2. Use the LEFT and RIGHT buttons to set the white
balance to the desired value. The value you set will be
displayed on the LCD monitor.
AUTO
: The camera automatically
selects the appropriate white
balance settings, depending on the prevailing lighting conditions.
DAYLIGHT
: For taking images outside.
CLOUDY
: For taking images under a cloudy and overcast sky.
Fluorescent H
: For shooting under daylight fluorescent types of three-way
fluorescent lighting.
Fluorescent L
: Shooting under white fluorescent lighting.
TUNGSTEN
: For shooting under tungsten (standard light bulb) lighting.
CUSTOM
: Allows the user to set the white balance according to the shooting
condition.
Different lighting conditions may cause a colour cast on your images.
3. Press the +/- button again. The value you set will be saved and White Balance setup mode
will end.
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+/- button
● Using the Custom White Balance
White balance settings may vary slightly depending on the shooting environment. You can
select the most appropriate white balance setting for a given shooting environment by setting
up the custom white balance.

1. Select the CUSTOM (
) menu of the White Balance.
You can select CUSTOM 1 or CUSTOM 2 white
balance.
2. Place a sheet of white paper in front of the camera so
that the LCD monitor shows only white, and then press
the SHUTTER button.
3. The value you set will be saved.
- The custom white balance value will be applied, starting
with the next picture you take.
- The user configured white balance will remain effective
until it is overwritten.

9

8

[White paper]

■ Exposure compensation : This camera automatically adjusts the exposure according to the
ambient lighting conditions.
You can also select the exposure value by using the +/- button.
● Compensating Exposure
1. Press the +/- button, and then use the UP and DOWN
buttons to select the exposure compensation icon (
).
The exposure compensation menu bar will appear as
shown.
2. Use the LEFT and RIGHT buttons to set the desired
exposure compensation factor.
3. Press the +/- button again. The value you set will be
saved and the Exposure Compensation setup mode will close. If you change the exposure
value, the exposure indicator (
) will be displayed on the bottom of the LCD monitor.
* A negative exposure compensation value reduces the exposure.
Note that a positive exposure compensation value increases the exposure and the LCD
monitor will appear white or you may not get good pictures.
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AEL/ASM button
■ The camera measures brightness of the object and automatically set the best exposure
value. If difference between the exposure values of the object and background is too great,
use the AEL button to manually set the exposure value against sunlight or in strong light.
This button is available in the PROGRAM, Aperture priority(A), Shutter priority(S), MySET
and MOVIE CLIP mode.
● Use the automatic exposure lock.
1. Ensure the subject in the centre of the autofocus frame.
2. Move the camera to point the automatic focus mark on the object of desired exposure.
3. Press the AEL button to lock the exposure and display the AEL icon in the bottom of the
LCD.
4. Focus the camera again and press the shutter button again for shooting.

[ Screen for shooting ]

[ Focus to the object and ]
press the AEL button

[ Refocus and fully press ]
the shutter button

■ You can use the ASM button to select the Aperture Value and Shutter speed in the Manual mode.
● Using the ASM button in the M mode
1. Rotate the MODE DIAL to select the M mode.
2. Press the ASM button and the aperture value and
shutter speed are displayed. To select the aperture
value or shutter speed, press the ASM button.
The selected item is then highlighted in red.
3. Rotate the jog dial to select the aperture value and
shutter speed. Press the SHUTTER button to take the
picture.
※ In the Manual mode, the exposure information will be displayed by pressing the shutter
button down halfway. (
)
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MF button
Use this button to select the focusing method.
● Automatic focusing : Slightly press the shutter to let the camera measure distance to the
object and select the best focusing.
If successfully focused with the slight press of the shutter, the automatic
focusing mark is turned green.
● Manual focusing : Where the automatic focusing is not available, for example, in very dark
conditions, use the manual focus. Please be careful when using the
manual focus as the picture can be blurred easily.

● Manual focusing.
1. Press the MF button to display the MF bar.
The MF icon is displayed in the bottom of the LCD.

2. Use the jog dial to set the focus distance.
Turn to the left : Move the focus farther.
Turn to the right : Move the focus closer.
Close-up

Long distance

INFORMATION
● Focus distance of 0.04~0.25m are only supported in the Wide zoom. If you take a picture
within 0.2m, select the Flash off mode as the flash range is 0.2m or farther.
● The focus value displayed in the LCD while manually focusing is measured from the end
of the lens
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Using the LCD monitor to adjust the camera settings
■ You can use the menu on the LCD monitor to set up recording functions. In any mode with
the exception of VOICE RECORDING mode, pressing the MENU button displays the menu
on the LCD monitor.

INFORMATION
● The menu will not be displayed on the LCD monitor in the following circumstances:
- When another button is being operated.
- While image data is being processed.
(when the green lamp next to the viewfinder blinks)
- When there is no battery capacity.

■ The following functions are available, depending on the mode you have selected.
The items indicated by
Menu tab

Main menu

are default settings.
Sub menu

Camera working mode

Page

3264X2448
3072X2304
2816X2112
2592X1944
2272X1704

p.47

2048X1536
Size
1600X1200
1024X768
640X480
640X480
320X240

p.47

160x128
30 FPS
Frame Rate
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p.48
15 FPS

Using the LCD monitor to adjust the camera settings
Menu tab

Main menu

Sub menu

Camera working mode

Page

TIFF
Quality

p.48

Super Fine
Fine
Normal
Multi

Metering

p.49

Spot
Single
Continuous
Shooting

p.50

AEB
AFB
Soft
Normal

Sharpness

p.51

Vivid
Normal
B&W
Sepia
p.51

Red

Effect

Green

(

)

Blue
Negative
Highlight

Off
Range 1~4

p.52~53

Off
Special Effect

Composite

2~4 Part

p.54~55

Pano.2 parts

OSD Information

Off

Photo
Frame

Frame 1~9

Full OSD

Histogram

p.56

Basic OSD Save mode

p.57
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Using the LCD monitor to adjust the camera settings
Menu tab

Main menu

Sub menu

Camera working mode

Page

Myset1
Save Myset

Myset2

p.58

Myset3
Myset1
Load Myset

Myset2

p.58

Myset2

Scene

Nightscene, Portrait,
Children, Landscape,
Close-up, Text, Sunset,
Dawn, Backlight,
Fireworks, Beach&Snow

p.59

Off
Stabiliser

On

* Menus are subject to change without prior notice.
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p.60

How to use the menu
1. Turn on the camera and press the MENU button. A menu for each camera mode appears.
However, there is no menu for Voice Recording mode (
).
2. Use the LEFT and RIGHT buttons to navigate through the menus.
Press the LEFT
or RIGHT button.

Size

3264X2448

Quality

TIFF
Super Fine

3072X2304
2816X2112
2592X1944
2272X1704
2048X1536

Press the LEFT
or RIGHT button.

Metering

Multi
Spot

Fine
Normal

3. Use the UP and DOWN buttons to select a sub menu.
Press the UP or
DOWN button.

Quality

TIFF
Super Fine

Quality

TIFF

Super Fine

Fine

Press the UP or
DOWN button.

Quality

TIFF
Super Fine
Fine
Normal

Fine
Normal

Normal

4. Select a sub menu, and then press the OK button. The value you set will be saved and the
menu will disappear.

Size
■ You can select the image size appropriate for your application.
Mode
Icon

MOVIE CLIP mode

STILL IMAGE mode
8M

7M

6M

5M

4M

3M

2M

1M

VGA

640

320

160

Size 3264X2448 3072X2304 2816X2112 2592X1944 2272X1704 2048X1536 1600X1200 1024X768 640X480 640X480 320X240 160X128

Size

Size

3264X2448

640X480

3072X2304
2816X2112
2592X1944
2272X1704
2048X1536

320X240
160X128

[ PROGRAM mode ]

[ MOVIE CLIP mode ]

INFORMATION
● The higher the resolution, the lower the number of available shots will be because high
resolution images require more memory than lower resolution images.
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Quality
■ You can select the compression ratio appropriate for your application of the captured images.
The higher the compression ratio, the lower the picture quality.

Quality

Frame Rate

30 FPS

TIFF
Super Fine

15 FPS

Fine
Normal

[Movie clip mode]

[Program mode]

STILL IMAGE mode

Mode

MOVIE CLIP mode

Icon

TIFF

Sub menu

TIFF

Super Fine

Fine

Normal

30FPS

15FPS

File Format

tif

jpeg

jpeg

jpeg

avi

avi

INFORMATION
● TIFF is the highest quality and Normal is the lowest setting.
Choose the setting appropriate for your needs.
● The TIFF file format is for professionals and provides the best quality.
However, large file size reduces number of available pictures to take and increases
saving time to the memory card.
● [Processing!] message is displayed while saving a TIFF file to the memory card.
● The TIFF file format can't be selected in the Auto mode.
● Though the TIFF menu displays in the LCD monitor in Continuous, AEB and AFB
shooting mode, but can't be selected.
● If you select the TIFF file format, the double self-timer can’t be selected.
● The digital zoom can't be used when you select the TIFF file format.
● This file format complies with the DCF(Design rule for Camera File system).
● JPEG (Joint Photographic Experts Group): JPEG is the image compression standard
developed by the Joint Photographic Experts Group. This type of compression is most
commonly used for compressing photos and graphics because it can compress the files
efficiently without damaging the data.
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Metering
■ If you cannot obtain suitable exposure conditions, you can change the metering method to
take brighter pictures.
Multi (

Spot (

)

)

: Exposure will be calculated based on
an average of the available light in the
image area.
However, the calculation will be biased
towards the centre of the image area.
This is suitable for general use.

Metering

Multi
Spot

[ PROGRAM mode ]

: Only the rectangular area in the centre
of the LCD monitor will be metered for
light. This is suitable when the subject in the centre is exposed correctly,
regardless of the back lighting.

INFORMATION
● The default metering mode is Multi pattern metering.
● If the subject is not the centre of the focus area, do not use the spot metering as this may
result in an exposure error. In this circumstance, It is better to use exposure
compensation.
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Continuous shot
■ You can select continuous shot, AEB (Auto Exposure Bracketing) and AFB (Auto Focus
Bracketing). If you select CONTINUOUS, AEB or AFB, the flash will automatically be set to
Flash Off.
[Single]: Take one picture only
Shooting

[Continuous]: Images will be taken continuously until the
shutter button is released. The shooting
capacity depends on the memory.

Single
Continuous
AEB
AFB

[ PROGRAM mode ]

[AEB]: You can select the exposure bracket range
(±0.3EV step, 6 steps) by rotating the jog dial.
Three pictures are taken in a series in different
exposure value. Use this menu if it is hard to decide
exposure of the object.

[AFB]: You can select the focus bracket range(±1 step,
3 steps) by rotating the jog dial. Three pictures are
taken in a series in different focus range. Use this
menu if it is hard to decide distance of the object.

Shooting
Single
Continuous

AEB
AFB

Shooting
Single
Continuous
AEB

AFB

INFORMATION
● If 1 picture is available in the memory, the continuous shot is not available. If less than
2 pictures are available in the memory, the AEB, AFB shooting are not available.
● It is best to use a tripod support for the AEB shooting for saving time is long and hand
shaking may occur.
● Selecting the TIFF file format, you can’t select the Continuous, AEB, AFB shooting mode.
● When you select the Continuous shooting mode, the self-timer function will not activate.
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Sharpness
■ You can adjust the sharpness of the picture you want to take.
You cannot check the sharpness effect on the LCD monitor
before you take a picture, because this function is applied
only when the captured image is stored on the memory.

Sharpness
Soft

Normal
Vivid

[ PROGRAM mode ]

Sub menu

Icon

Description
The edges of the image are softened.
This effect is suitable for editing images on your PC.

Soft

The edges of the image are sharp.
This is suitable for printing.

Normal

The edges of the image are emphasized. The edges will appear
sharp, but noise may occur in the recorded image.

Vivid

Effect
■ By using the camera's digital processor, it is possible to add special effects to your images.

Effect

Effect

Normal

Normal

B&W
Sepia
Red
Green
Blue

B&W
Sepia
Red
Green
Blue

[ PROGRAM mode ]

[ MOVIE CLIP mode ]

[Normal]
[B & W]
[Sepia]

: No effect is added to the image.
: Captured images will be stored in black and white.
: Captured images will be stored in a sepia tone
(a gradient of yellowish brown colours).
[Red]
: Captured images will be stored in a red tone.
[Green] : Captured images will be stored in a green tone.
[Blue]
: Captured images will be stored in a blue tone.
[Negative] : Save the image in negative mode.
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Special Effect
■ By using the camera’s digital processor, it is possible to add special effects to your images.
You can select this menu only in the PROGRAM, MySET, Aperture priority, Shutter priority
and MANUAL modes.
■ You can select the preset focus frame, Composite shots and Photo frame function.
If a special effect is selected, the rest special functions set before are cancelled automatically.
■ Even if the camera is turned off, the special effect setting will be preserved. To cancel the
special effect, select the [Off] sub menu of each menu.
■ If you select the [TIFF] image size and select the [Special Effect] menu, the image size will be
changed to the [Super Fine] image size automatically.
■ If you select a special effect menu and select [Continuous], [AEB] or [AFB] menu, the special
effect menu will be cancelled automatically.

Special Effect : Preset focus frames
■ You can make the subject stand out from its surroundings. The subject will be sharp and in
focus while making the rest out of focus.
1. Select the PROGRAM, MySET, Aperture priority, Shutter
priority or MANUAL modes. Then press the menu button.
2. Press the LEFT/ RIGHT button and select the [Special
Effect] menu tab.
3. Select the [Highlight] menu by pressing the UP/ DOWN
button and press the Right button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
- [Off] : The preset focus frame will not be added.
[Range 1]

[Range 2]

Special Effect

Highlight

Off

Composite
Photo Frame

Range 1
Range 2
Range 3
Range 4

Back:◀

[Range 3]

Set:OK

[Range 4]

5. Press the menu button twice and the menu will disappear.
If you select the [Range 1~4] menu, the preset focus
frame area will appear.

9

8

Capture:SH
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Edit:+/-

Special Effect : Preset focus frames
● Moving and changing the focus frame
You can change the focus frame after selecting a Range menu.
1. Point the camera towards the subject and compose the image by using the LCD monitor.
2. Press the +/- button.
3. The colour of focus frame turns white. Press the Up/Down/Left/Right button to moves the
focus frame position.
4. To select the focus frame position, press the +/- button again and you can take a picture.

Pressing the +/- button
Capture:SH

Capture:SH

Edit:+/-

Move:

[The frame is activated]

Pressing the
Up/ Down/ Left/
Right button

Pressing the +/- button
Capture:SH

Move:

Capture:SH

Move:

[After changing the frame position]
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Special Effect : Composite shooting
■ You can combine 2 ~ 4 different shots in a still image.
1. Select the MANUAL mode, and press the menu button.
2. Press the LEFT/ RIGHT button and select the
Special Effect
HighLight
[Special Effect] menu tab.
Off
Composite 2 Parts
3. Select the [Composite] menu by pressing the UP/ DOWN
Photo Frame
3 Parts
4 Parts
button and press the Right button.
Pano.2 Part
4. Select a desired sub menu by pressing the UP/ DOWN
Back:◀
Set:OK
button and press the OK button.
- [Off]
: cancels the composite shooting
- [2 Parts]
: 2 different shots are combined in a still image.
- [3 Parts]
: 3 different shots are combined in a still image.
- [4 Parts]
: 4 different shots are combined in a still image.
- [Pano. 2 Parts] : 2 different panorama shots are combined in a still image.
5. Press the menu button twice and the menu will disappear.
6. The number of frames you selected in step 4 is displayed on the LCD monitor.
Press the shutter button to start the composite shooting
※ Selecting 2 composite shooting
Pressing
the shutter
button

9

8

Capture:SH

[Ready for taking]

Del:+/-

[First shot]

Pressing
the shutter
button

9

8

Save:OK

Pressing
the OK
button

100-0009

Del:+/-

[Second shot]

[The final picture]

7. To save the composite shots, press the OK button after taking the last shot.
※ You can use the flash button, self-timer button, macro button, voice memo button and the
Zoom W/T button during the composite shooting.
※ If you press the camera buttons during the composite shots,
9
8
each mode of the camera buttons is executed. The images
Menu?
captured before will be deleted.
Menu
※ If you press the Menu button during the composite shots, a
Cancel
window will display. Select the submenu value by pressing the
Confirm:OK
Up/Down button and then press the OK button.
Capture:SH
Del:+/[Menu] : A menu will display. After confirming a menu,
a camera mode used before will be executed.
[Cancel] : Turns to the previous capture mode.
※ After taking the last composite shooting, press the OK button. And then the voice memo will
start.
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Special Effect : Composite shooting
● Changing a part of composite shot before taking the last shot
Before taking the last composite shot, you can change a part of composite shot.
1. During the composite shots, press the +/- button.
2. A previous image will be deleted and new frame will display. If there is an image taken
before, press the +/- button again and a previous image will be deleted again.
9

9

8

8

Pressing the +/- button
Capture:SH

Del:+/-

Capture:SH

[Before taking the 3rd shot]

Del:+/-

[Moving backward to the 2nd shot]

3. Press the shutter button to capture a new image.

● Changing a part of composite shot after taking the last shot
After taking the last composite shot, you can change a part of composite shot.
1. After taking the last shot , a cursor to select a frame will display.
Press the Up/ Down/ Left/ Right button to select the frame.
2. Press the +/- button and an image will be deleted. Composite frame will be activated.
3. Press the Shutter button. You can take another images again by using the
Up/ Down/ Left/ Right button and +/- button.
4. Press the OK button again to save the captured image.

9

8

Save:OK

9

Pressing the
Up button

8

Del:+/-

Save:OK

[After taking the 4th shot]

9

Pressing the
+/- button

8

Del:+/-

[Moving backward to the 2nd shot]

[Deleting the 2nd shot]
Pressing the
Shutter button.

9

8

9

Pressing the
OK button

8

Save:OK

[The final picture]

Del:+/-

[After taking the 2nd shot again]

《55》

Special Effect : Photo Frame
■ You can add 9 types of frame-like borders to a still image you want to capture.
■ Date & Time information will not be printed on the stored image taken with [Photo Frame]
menu.
1. Select the MANUAL mode, and press the menu button.
2. Press the LEFT/ RIGHT button and select the
[Special Effect] menu tab.
3. Select the [Photo Frame] menu by pressing the UP/ DOWN
button and press the Right button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
- [Off] : The photo frame will not be added.

Special Effect
HighLight
Off
Composite
Frame1

Photo Frame Frame2
Frame3
Frame4
Back:◀

Set:OK

[Frame 1]

[Frame 2]

[Frame 3]

[Frame 4]

[Frame 5]

[Frame 6]

[Frame 7]

[Frame 8]

[Frame 9]

5. Press the menu button twice and the menu will disappear.
If you select the [Frame 1 ~ 9] menu, the selected photo
frame will appear.
※ Before taking a picture, you can change the frame type by
pressing the +/- button. Change the frame type by
pressing the Up/ Down/ Left/ Right button.
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9

8

Capture:SH

Frame:+/-

On Screen Display Information
■ In any mode with the exception of VOICE RECORDING
mode, you can check the recording status in the LCD
monitor or select the power save mode.

OSD Information

Full OSD

■ Histogram shows you the distribution of brightness in
recorded images. If the bars in the histogram are higher
towards the right, the image may be too bright. If the bars
are higher on the left, the image may be too dark. If the
lighting conditions are too bright to check the subject by
using the LCD, checking the histogram will enable more
precise exposure control for the shots.

Pixel

Histogram
Basic OSD
Save Mode

Distribution of brightness
Dark
Bright

■ Idle mode : If you select the [SAVE MODE] and the camera isn't operated during the
specified time(about 30 SEC.), the camera power will be idle (LCD monitor : OFF,
Camera status lamp : Blinking) automatically. To use the camera again, press
any of the camera buttons except the power button. If there is no operation during
the specified time, the camera power will be turned off automatically to save
battery life. Refer to page 95 for more information about the auto power off
function.

[Full OSD]

[Histogram]

[Basic OSD]

[Save mode : LCD off]
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Save / Load a specific camera configuration (MySET)
■ Use the MySET mode to save frequently used camera settings (Save Myset) and use it later
(Load Myset)
● Saving the camera configuration : Available in the PROGRAM, A, S and M shooting mode.
1. Use the camera buttons and menu to set desired camera configuration.
2. Press the menu button in any mode except AUTO,
VOICE RECORDING, MOVIE CLIP, SCENE and MySET
Save Myset
mode.
Myset 1
Myset 2
3. Press the Left/Right buttons to select the [Save Myset]
Myset 3
menu tap.
4. Press the Up/Down buttons to select desired MySET slot
number to save.
[ PROGRAM mode ]
5. Press the OK button to save the current configuration in
the selected MySET slot and close the menu.
● Loading the saved camera configuration: available in the MySET shooting mode.
1. Turn the mode dial to select the MySET shooting mode
and press the menu button.
Load Myset
2. Press the Left/Right buttons to select the [Load Myset]
Myset 1
Myset 2
menu tap.
Myset 3
3. Press the Up/Down buttons to select a MySET slot
number to load.
4. Press the OK button to set the camera configuration as
[ MySET mode ]
saved in the MySET slot.
* The current MySET slot number is displayed in the top left of the LCD.

INFORMATION
● Saving is available for the following camera functions.
Functions using the camera buttons - Macro, flash, white balance, ISO, RGB, Exposure
value, Aperture value and Shutter speed.
Functions using the menu screen
- Size, quality, metering, effect, sharpness and
continuous shot.
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Scene
■ Select the [Scene] submenu to automatically configure
optimal settings, depending on the selected scene.
Only available in the SCENE Mode.

Scene

Nightscene
Portrait
Children
Landscape
Close Up
Text

[SCENE mode]

Sub menu

Icon

Nightscene

Description
Use this for shooting still images at night or in other dark conditions.

Portrait

To take a picture of a person

Children

To take a still picture of moving children

Landscape

Scenery with green woods or blue sky

Close up
Text

Close-up shooting for small objects such as plants and insects
Use this mode to shoot a document

Sunset

For taking pictures of sunsets

Dawn

Daybreak scenes

Backlight

Portrait without shadows caused by backlight

Firework

Firework scenes

Beach&Snow

For ocean, lake, beach and snowscape scenes

INFORMATION
● When the close-up, sunset, dawn, fireworks are selected, it is possible that camera shake
will occur. If this is the case, use a tripod to eliminate this.
● In the [Children] and [Close up] scene mode, the Continuous Automatic Focusing (CAF)
function will be activated and the CAF icon is displayed at the bottom of the LCD monitor.
● Continuous automatic focusing : The camera keeps focusing while the object is moving
even if the shutter button is not slightly pressed. Note that using the Continuous automatic
focusing uses more battery than the Automatic focusing does.
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Movie Clip frame stabiliser
■ This function helps stabilise images captured during movie recording.
You can select this menu only in the MOVIE CLIP mode.
● How to use this function
1. Select the MOVIE CLIP mode by rotating the mode dial
and press the menu button. Select the [Stabilizer] menu
Stabilizer
and press the right button.
Off
On
2. Select a desired sub menu by pressing the Up/Down
button and press the OK button.
[Off] : Movie clip frame stabilizer function becomes
disabled.
[On] : Prevents camera shake during movie recording.
The recording frame range will become narrower than when you select the [Off]
menu. Pre-view frames may not display smoothly on the LCD monitor, but stored
movie clips have no problems.

INFORMATION
● When you select the [On] sub menu, the movie clip frame range will be narrow depending
on the movie clip size.
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Starting play mode
■ Turn the camera on and select Play mode by pressing the play mode button (
).
The camera can now play back the images stored in the memory.
■ If you have turned on the camera by pressing the POWER button, you can press the PLAY
MODE button once to switch to Play mode and press it again to switch to Recording mode.
■ You can turn the power on with the play mode button. The camera is turned on in play mode.
Press the play mode button again to turn off the camera. Switch the mode dial to change to
another shooting mode while the camera is on.
■ You can set up the PLAY mode function by using the camera buttons and LCD monitor.
■ If you press the PLAY button to switch to Play mode, the camera lens will retract into the
camera body for protection of the lens after about 10 seconds.
■ If the memory card is inserted in the camera, all the camera functions apply only to the
memory card.
■ If the memory card is not inserted in the camera, all the camera functions apply only to the
internal memory.
● Playing back a still image
1. Select the PLAY mode by pressing the play
mode button (
).

2. The last image stored on the memory is
displayed on the LCD monitor.

100-0009

3. Select an image that you want to view by
pressing the LEFT / RIGHT button.
※ Press and hold the LEFT or RIGHT button to
play back the images quickly.

INFORMATION
● Manner mode : Pressing the play mode button for more than 3 seconds changes the
buzzer and start-up
buzzer
sound
andsetting
start-up
tosound
OFF, even
setting
though
to OFF.
you may have set these to ON.
● Even if the camera’s power is off, you can start the play mode by pressing the play mode
button.
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Starting play mode
■ Playing back a movie clip
Steps from 1-2 are the same as those to play back a still image.
3. Select the recorded movie clip that you want to play back
by using the LEFT/RIGHT button. If you select a movie
clip, the movie clip indicator (
) will be displayed on
the LCD monitor.
4. Press the play & pause button (
) to play back a
movie clip file.
- To pause a movie clip file while playing it back, press
the play & pause button again.
- Pressing the play & pause button again will cause the
movie clip file will restart.
- To rewind the movie clip while it is playing, press the
LEFT button. To fast forward the movie clip, press the
RIGHT button.
- To stop playback of the movie clip, press the play &
pause button, and then press the LEFT or RIGHT button.

PLAY?

■ Movie clip capture function: capture still images from the movie clip.
● How to capture the movie clip
Steps 1-2 are the same as those for playing back a still
image.
3. Select the recorded movie clip that you want to play
back by using the LEFT/RIGHT button.
4. Press the Play/Pause button to play the movie clip
5. Press the Play/Pause button while playing the movie
clip. Then press the Shutter button.
6. The paused movie clip is saved in a new file name.
* The captured movie clip file has same size as the original
movie clip (640X480, 320X240, 160X128).

100-0006

Trim:T

Capture:SH

PLAY?

[ Paused ]

[ Press the shutter button ]
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Starting play mode
■ On camera movie trimming : You can extract desired frames of movie clip during the movie
clip play back.
1. Select a desired movie clip in the play mode.
100-0006
2. Play back the movie clip by pressing the Play &
Pause button.
3. Press the Pause button at the point of the movie clip
Trim:T
Capture:SH
that you want to start extracting.
PLAY?
4. Press the T button. The start point doesn't display on
the status bar, but the start point will be selected.
5. Press the Play button and the extracted range will be
displayed on the status bar.
6. At the point of movie clip that you want to stop
100-0006
extracting, press the Pause button.
7. Press the T button and a confirmation window will
display.
Trim:T

PLAY?

8. Select a desired sub menu by pressing the UP/
DOWN button and press the OK button.
[Trimming] : The extracted frames are saved as a
new file name.
[Cancel]
: The movie trimming will cancel.

100-0006

Trimming?
Trimming
Cancel
Confirm : OK

PLAY?

INFORMATION
● If the running time is under 10 seconds, the movie clip can’t be trimmed.
● If you want to extract the movie clip at the beginning of the frame, press the Zoom T
button before starting the movie clip.
● If the time line bar passes by the start point by pressing the REW(Left) button, the first
frame of the movie clip will display.
● If you doesn’t specify the ending point of the movie clip, the trimming confirmation
window will display at the point of the last frame.
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Starting play mode
■ Playing back a recorded voice
Steps from 1-2 are the same as those to play back a still
100-0002
image.
3. Select the recorded voice that you want to play back by
using the LEFT/RIGHT button. If you select a recorded
voice file, the voice indicator (
) will be displayed on
the LCD monitor.
PLAY?
4. Press the play & pause button (
) to play back a
recorded voice file.
- To pause a recorded voice file, while playing it back,
press the play & pause button again.
- To resume playback of the voice file, press the play & pause button.
- To rewind the voice file while it is playing, press the LEFT button.
To fast forward the voice file, press the RIGHT button.
- To stop playback of the voice file, press the play & pause button, and then press the
LEFT or RIGHT button.
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LCD monitor indicator
■ The LCD monitor displays shooting information about the displayed image.
①
②

⑰

③

⑯
⑮

④

⑭

⑤

⑬
⑫
⑪
⑩
⑨

⑥
⑦
⑧

No.

Description

Icon

Page

1

Battery

p.15

2

Play mode icon

p.61

3

File type

p.24, 26

4

Flash

p.35

5

Voice memo

p.31

6

Protect

p.79

7

DPOF icon

p.83

8

Histogram

p.57

9

Recording date

2005/08/01

p.97

10

Exposure Value

EV -2.0 ~ 2.0

p.41

11

ISO

50 ~ 400

p.40

12

Shutter speed

15 ~ 1/2,000

p.22~23

13

Aperture Value

F2.8 ~ F7.7

p.22~23

14

Sharpness

p.51

15

TIFF

p.48

16
17

Image size

3264 X 2448 ~ 256 X 192

Recording time (Movie clip)

00:01:30

Folder name & File name

100-0009

p.47
p.94
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Using the camera buttons to adjust the camera
■ In Play mode, you can use the buttons on the camera to conveniently set up the Play mode
functions.

Thumbnail (

) / Enlargement (

) button

● You can view multiple pictures, enlarge a selected picture, and crop and save a selected area
of an image.
● Thumbnail display
1. While an image is displayed full screen, press the
thumbnail button.
2. The thumbnail display will highlight the image that had
been showing at the time the thumbnail mode was
selected.
3. Press the 5 function button to move to a desired image.
4. To view an image separately, press the enlargement
button (
).
100-0009

Pressing the thumbnail
button (
)

Pressing the enlargement
button (
)
Highlighted image
[ Normal display mode ]

[ Thumbnail display mode ]

● Image enlargement
1. Select an image that you want to enlarge and press the enlargement button.
2. Different parts of the image can be viewed by pressing
the 5 function button.
3. Pressing the thumbnail button will zoom back to the
original full sized image.
- You can tell whether the image displayed is an
enlarged view by checking the image enlargement
indicator shown at the bottom left of the LCD monitor.
(If the image is not an enlarged view, the indicator will
not be displayed.) You can also check the area of
enlargement.
- TIFF, Movie clips and WAV files can’t be enlarged.
- If an image is enlarged, a loss of quality may occur.
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Thumbnail(

) / Enlargement(

) button

● The maximum enlargement rate in proportion to the image size.
Image size

3264

3072

Maximum enlargement rate X12.75 X12.0

2816

2592

2272

2048

1600

1024

640

X11.0 X10.13 X8.88

X8.0

X6.25

X4.0

X2.5

● Trimming : You can extract part of the image that you want
and save it separately.
Trimming?
1. Select an image that you want to enlarge and press the
Trimming
Cancel
enlargement button.
Confirm:OK
2. Different parts of the image can be viewed by pressing
the 5 function button.
3. Press the MENU button and a message will be
displayed as shown alongside.
4. Select a desired sub menu by pressing the UP/ DOWN button and press the OK button.
- [Trimming] : The trimmed image will save as a new file name, and display on the LCD
monitor.
- [Cancel]
: The trimming menu will disappear.
* If there is little memory space to save the trimmed image, the image can’t be trimmed.

Voice (

) memo / Up button

■ When the menu is displayed on the LCD monitor, pressing the UP button makes the menu
cursor move up.
■ When the menu is not displayed on the LCD monitor, the UP button operates as the voice
memo button. You can add your voice to a stored still image.

● Adding a Voice Memo to a Still Image
1. Press the LEFT/ RIGHT button to select an image that
you wish to add sound to.
2. Press the voice memo button (
) and the voice memo
indicator will display. The camera is now ready to record
a voice memo.
Start : Shutter
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Voice (

) memo / Up button

3. Press the shutter button to start recording and voice will
be recorded to the still image for 10 seconds.
While the voice is recording, the recording status
window will be displayed as shown alongside.

100-0011

STOP:SHUTTER

4. The recording can be stopped by pressing the shutter
button again.
5. The (
) icon will be displayed on the LCD monitor
after voice memo recording has finished.
- Voice memos can’t be recorded onto movie clip files.
- A distance of 40cm between you and the camera
(microphone) is the best distance to record sound.
- The voice memo will be saved in *.wav format, but has
the same file name as the still image to which it
corresponds.
- If you add a new voice memo to the still image that
already has a voice memo, the existing voice memo will be erased.

Play & Pause (

100-0011

)/ Down button

■ In Play mode, the play & pause/ down button works as follows:
- If the menu is displayed
Press the DOWN button to move from the main menu to a sub menu, or to move down the
sub menu cursor.
- If a still image with a voice memo, a voice file, or a movie clip is playing
In Stop mode
: Plays a still image with a voice memo, a voice file, or a movie clip.
During playback : Temporarily stops playback.
In Pause mode : Resumes playback

100-0008

PLAY?

[ Voice recording is stopped ]
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100-0008

PAUSE?

[ Voice recording is playing ]

100-0008

PLAY?

[ Voice recording is paused ]

LEFT/ RIGHT/ MENU/ OK button
■ LEFT / RIGHT/ MENU/ OK buttons activate the following.
- LEFT button
: While the menu is showing, press the LEFT button to select the menu
tab to the left of the cursor.
- RIGHT button
: While the menu is showing, press the RIGHT button to select the menu
tab to the right of the cursor, or to move an secondary menu.
- MENU button
: When you press the MENU button, the play mode menu will be
displayed on the LCD monitor. Pressing it again will return the LCD to
the initial display.
- OK button
: When the menu is displayed on the LCD monitor, the OK button is used
for confirming data that is changed by using the 5 function button.

Print button (

)

■When the camera is connected to a PictBridge Printer
with supplied USB cable, currently displayed image will
be printed with the printer's default setting by pressing
this button.
- Though the [USB] menu is set to [Computer], the
camera will recognize the printer by pressing this
button while the camera searches for the external
device. But, the camera may not connect to the printer and turn off according to the printer
manufacturer. Refer to page 88 for more information about how to connect the computer
and the printer.
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Delete (

) button

■ This deletes images stored on the memory card.
● Deleting Images in Play Mode
1. Select an image that you want to delete by pressing the
LEFT / RIGHT button and press the DELETE (
)
button.
2. A message will display as shown alongside on the LCD
monitor.
3. Select the submenu values by pressing the UP/DOWN
button and then press the OK button.
If [Delete] is selected: deletes the selected images.
If [Cancel] is selected: cancels "Delete Image".

100-0009

Delete?
Delete
Cancel
Confirm:OK

● Deleting Images in Thumbnail Display Mode
1. Use the Up/Down/Left/Right buttons to select an image to delete.
2. Press the Delete button to display the following message in the LCD monitor.

1

2

3

Press the
DELETE
button.

1

4

5

6

4

7

8

9

7

2
Delete?
Delete
Cancel
Confirm:OK

3

5

6

8

9

3. Select the submenu values by pressing the UP/DOWN button and then press the OK button.
If [Delete] is selected : deletes the selected images.
If [Cancel] is selected : cancels "Delete Image".

INFORMATION
● Before deleting images from the camera, you should protect (p.79) or download images
(p.125~126, 132~133) to your computer that you wish to keep.
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Album button (MF button)
■ You can organise the captured still images(except for the
TIFF file type image) into albums by using the MF button.
■ This camera has 8 albums and each album can take up
to 100 images.
■ The album menu loading time depends on the memory
card type.
■ If there are over 300 images in the memory, the [Add]
menu takes a little longer for the camera to process.

■ How to use the album
● Selecting the album
1. In the play mode, press the MF button.

Slide
Add
Remove

2. Select the [Select] menu by pressing the Up/Down
button and press the Right button.

3. Select a desired album by pressing the
Up/Down/Left/Right buttons and press the OK button.

All

A1

A2

A3

A4

A5

A6

A7

A8

Select

Exit:MENU

Move :

All

A1

A2

A3

A4

A5

A6

A7

A8

Select
Slide
Add
Remove

Set : OK

● Inserting still images into the album
1. Select an album.
2. Select the [Add] menu by pressing the Up/Down
button and press the Right button.

A4

Select
Slide
Add
Remove
Select:T

Set:OK
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Album button (MF button)
3. Select the still images you wish to add by pressing the
Up/Down/Left/Right buttons and press the Zoom T
button.
marks are displayed on the selected images.
* To cancel the selection, press the Zoom T button again.

A4

Select
Slide
Add
Remove
Select:T

4. Press the OK button and a confirmation window will
display. Select a desired sub menu by pressing the UP/
DOWN button and press the OK button.
[Add] : Inserts the selected images into the album.
[Cancel] : Cancels the inserting images.

A4

Select
Slide
Add
Remove

Add?
Add
Cancel
Confirm:OK

Select:T

● Removing still images from the album
1. Select an album.
2. Select the [Remove] menu by pressing the Up/Down
button and press the Right button.
3. Select a desired sub menu and press the OK button.
- [Select]: Specific still images in the album can be
removed.
- [All]
: All of the still images in the album will be
removed.
※ If [Select] is selected :
- Select images that you want to remove by pressing the
Up/Down/Left/Right buttons and press the Zoom T
button.
marks are displayed on the selected images.
4. Press the OK button and a confirmation window will
display.
Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Remove] : Removes the selected images from the
album.
[Cancel] : Cancels the removing images.
* The removed images are not deleted from the memory,
but just removed from the album.

A4

Set:OK

Select

Select

All

Slide
Add
Remove
Exit:MENU

Move :

A4

Select:T

Set:OK

A4

Remove?
Remove
Cancel
Confirm:OK
Select:T

《72》

Set:OK

Set:OK

Album button (MF button)
● Playing back the albums
◎ Playing back all of the albums
1. Select [All] menu and press the OK button.
All of the albums will be selected.
2. Select the [Slide] menu by pressing the Up/Down button
and press the Right button.
※You can select [Start], [Interval], [Repeat] and [Effect]
menus.
- [Start] : Start the slide show
- [Interval] : Set the slide show play interval
- [Repeat] : Choose to repeat the slide show after
finishing the first cycle.
- [Effect] : Unique screen effects can be used for the
slide show.
3. Select the [Start] menu by pressing the Up/Down button
and press the OK button to start the slide show.
4. To stop the slide show, Press the Play & Pause buttn
and MENU/OK button.
◎ Playing a desired album
1. Select a desired album and press the OK button.
2. Select the [Slide] menu by pressing the Up/Down button
and press the Right button.
※You can Select the [Start], [Interval], [Repeat] and
[Effect] menu.

All

A1

A2

A3

A4

A5

A6

A7

A8

Select
Slide
Add
Remove

Exit:MENU

Start
Select

Interval

1 Sec

Slide

Repeat

Off

Add

Effect

Cancel

Remove
Move:

Set:OK

A4
All

A1

A2

A3

A4

A5

A6

A7

A8

Select
Slide
Add
Remove

Exit:MENU

3. Select the [Start] menu and press the OK button to start
the slide show.
4. To stop the slide show, press the Play & Pause buttn
and MENU/OK button.

Move :

A4

Move :

Start

Select

Interval

1 Sec

Slide

Repeat

Off

Add

Effect

Cancel

Remove
Move:

Set:OK

INFORMATION
● If an image is deleted from the memory, the image doesn’t display on an album.
● An image can’t be added twice into the same album.
● An image can be added into the different albums.
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Setting up the play back function using the LCD monitor
■ PLAY mode functions can be changed by using the LCD monitor. In the PLAY mode,
pressing the MENU button displays the menu on the LCD monitor. The menus you can set
up in Play mode are as follows. To capture an image after setting up the play menu, press
the PLAY mode button or shutter button.
Menu tab

Main menu

Slide

Sub menu

Secondary menu

Start

-

Interval

1, 3, 5, 10sec

Repeat

Off, On

Page

p.77~78

Cancel
Effect
Effect 1~4, Random
Select
Protect

Unlock/ Lock

p.79

All Pics
Delete

Resize

Select

-

All Pics

-

3072 X 2304

-

2816 X 2112

-

2592 X 1944

-

2272 X 1704

-

2048 X 1536

-

1600 X 1200

-

1024 X 768

-

640 X 480

-

User Image

-

B&W
Effect

Rotate
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p.80

p.81

Green

Sepia

Blue

Red

Negative

p.82

Right 90º

-

Left 90º

-

180º

-

Horizontal

-

Vertical

-

p.83

Setting up the play back function using the LCD monitor
Menu tab

Main menu

DPOF

Copy To Card

Sub menu

Secondary menu

Standard

Select/ All Pics/ Cancel

Index

No/ Yes

Size

Select/ All Pics/ Cancel

No

-

Yes

-

Page

p.83

p.86

Full OSD
Image Information
OSD Information

p.87

OSD Off
Save Mode

■ This menu is available while the camera is connected to a PictBridge supporting printer
(direct connection to the camera, sold separately) with a USB cable.
Menu tab

Main menu
Images

Sub menu

Secondary menu

One Pic

-

All Pics

-

No

-

Yes

-

Auto Set

Page
p.89

p.90

Auto
Postcard
Card
4X6
Custom Set

Size

L

p.90

2L
Letter
A4
A3
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Setting up the play back function using the LCD monitor
Menu tab

Main menu

Sub menu

Secondary menu

Page

Auto
Full
1
2
Layout

4

p.90

8
9
16
Index
Auto
Normal
Custom Set

Type

Photo
Fastphoto
Auto
Draft

Quality
Normal
p.90
Fine
Auto
Date

Off
On
Auto

File name

Off
On

Standard

-

Index

-

No

-

Yes

-

No

-

Yes

-

Print

DPOF Print

Reset

※ Menus are subject to change without prior notice.
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p.91

p.91

p.92

Starting the slide show
■ Images can be displayed continuously at pre-set intervals.
You can view the slide show by connecting the camera to an external monitor.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Slide] menu tab.

● Start the slide show : The slide show can start only in the [Start] menu.
1. Use the Up/Down buttons to select the [Start] menu.
2. Press the OK button to start the slide show.
- Press the Pause button to pause the slide show.
Start
Interval
- Press the Pause button (
) again to resume the slide
Repeat
Effect
show.
- To stop the slide show, press the play & pause button, and
Move:
then press the LEFT or RIGHT button.

● Setting play interval: Set the slide show play interval.
1. Select the [Interval] sub menu by pressing the UP/DOWN
button and press the RIGHT button.
2. Use the Up/ Down buttons to select the desired interval.
3. Press the OK button to save the configuration.

Slide
1 sec
Off
Cancel
Set:OK

Slide
Start

1 sec

Interval

3 sec
5 sec
10 sec

Repeat
Effect
Back:◀

● Repeat setting : Setting the slide show to repeat after the first cycle.
1. Use the Up/ Down buttons to select the [Repeat] menu and
press the Right button.
2. Use the Up/Down buttons to select the desired sub menu.
Start
Interval
[On] selected : The slide show is repeated until cancelled.
Repeat
[Off] selected : The slide show is closed after one cycle.
Effect
3. Press the OK button to save the configuration.

Set:OK

Slide

Back:◀

Off
On

Set:OK

INFORMATION
● The loading time depends on the image size and quality.
● While the slide show is playing, only the first frame of a MOVIE file is displayed.
● While the slide show is playing, the voice recording file will not display.
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Starting the slide show
● Configure slide show effects: Unique screen effects can be used for the slide show.
1. Select the [Effect] sub menu by pressing the UP/ DOWN
button and press the RIGHT button.
Slide
2. Use the Up/ Down Button to select the type of effect.
Start
Cancel
Interval
Effect 1
[Cancel] : Normal display.
Repeat
Effect 2
Effect
Effect 3
[Effect 1] : Image is displayed slowly.
Effect 4
[Effect 2] : Image is displayed slowly from the centre
Back:◀
Set:OK
outwards.
[Effect 3] : Image moves from the top left.
[Effect 4] : The image slides diagonally from top left to bottom right.
[Random] : The image slides irregularly.
3. Press the OK button to confirm the setting.
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Protecting images
■ This is used to protect specific shots from being accidentally erased (Lock).
It also unprotects images that have been previously protected (Unlock).
● Protecting Images
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Protect]
menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Select ] : Selection window for an image to be
protected/released is displayed.
- Up/Down/Left/Right : Select an image
- Zoom W/T Button : Protect/release the image
- Menu Button
: Your changes will be saved and
the menu will disappear.
[All Pics] : Protect/release all saved images
- Zoom W/T Button : Protect/release the images
- Menu Button
: Your changes will be saved and the
menu will disappear.

Protect
Select
All Pics

Exit:MENU

W◀

Move:

Unlock

▶T

Set:OK

W◀

Unlock

▶T

Set:OK

- If you protect an image, the protect icon will be displayed
on the LCD monitor. (An unprotected image has no
indicator)
- An image in LOCK mode will be protected from the
delete function or [Delete] functions, but will NOT be
protected from the [Format] function.

《79》

Deleting images
■ Of all the files stored in the memory card, the unprotected files in the DCIM subfolder will be
deleted. Remember that this will permanently delete unprotected images.
Important shots should be stored on a computer before deletion takes place.
The startup image is stored in the camera's internal memory (i.e., not on the memory card)
and it will not be deleted even if you delete all files on the memory card.

● Deleting images
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Delete]
menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Select] : Selection window for an image to delete is
displayed.
- Up/Down/Left/Right : Select an image
- Zoom T Button
: Select the image for deletion.
(
mark)
- OK Button
: Press the OK Button to display the
confirmation message. Select the
[Delete] menu and press the OK
button to delete
marked
images.
[All Pics] : Displays confirmation window. Select the
[Delete] menu and press the OK button to
delete all unprotected images. If there aren’t
protected images, all the images are deleted
and a [No Image!] message will display.
4. After deletion, the screen will be changed to the play
mode screen.

《80》

Delete
Select
All Pics

Exit:MENU

Move:

Select:T
Del:OK

Delete?
Delete
Cancel
Confirm:OK
Del:OK

Resize
■ Change the resolution (size) of pictures taken. Select the [User Image] to save an image to
be the start-up image. The resized image will have a new file name.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Resize]
Resize
3072 X 2304
menu tab.
2816 X 2112
3. Select a desired sub menu by pressing the UP/ DOWN
2592 X 1944
2272 X 1704
button and press the OK button.
2048 X 1536

Exit:MENU

Move:

● Image Resize Types
2816X
2112

2592X
1944

2272X
1704

2048X
1536

1600X
1200

1024X
768

640X
480

User
Image

Resize

3072X
2304

8M

O

O

O

O

O

O

O

O

O

7M

X

O

O

O

O

O

O

O

O

6M

X

X

O

O

O

O

O

O

O

5M

X

X

X

O

O

O

O

O

O

4M

X

X

X

X

O

O

O

O

O

3M

X

X

X

X

X

O

O

O

O

2M

X

X

X

X

X

X

O

O

O

1M

X

X

X

X

X

X

X

O

O

VGA

X

X

X

X

X

X

X

X

O

INFORMATION
● A large sized image can be resized to a smaller sized image, but not vice versa.
● Only JPEG images can be resized.
TIFF, Movie clip(AVI) and Voice recording(WAV) files can’t be resized.
● You can change the resolution of only those files compressed in the JPEG 4:2:2 format.
● The resized image will have a new file name. The [User Image] image is stored not on the
memory card but on the internal memory.
● Only two [User Image] images can be saved. If you save a new [User Image] image, the
existing startup image will be deleted in order.
● If the memory capacity is insufficient to store the resized image, a [Card Full!] message
will display on the LCD monitor and the resized image will not be stored.
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Effect
■ By using the camera’s digital processor, it is possible to add special effects to your images.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Effect] menu
tab.
3. Select a desired sub menu by pressing the UP/ DOWN
button.
[B & W]
: Captured images will be stored in black and
white
[Sepia]
: Captured images will be stored in a sepia tone
(a gradient of yellowish brown colours).
[Red]
: Captured images will be stored in a red tone.
[Green]
: Captured images will be stored in a green tone.
[Blue]
: Captured images will be stored in a blue tone.
[Negative] : Save the image in negative mode.
4. Press the OK button and then a confirmation window will
display.
[Save] : The image with the effect added will be saved as a
new file with a new name.
[Cancel] : cancels the effect.
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Effect
B&W
Sepia
Red
Green
Blue
Exit:MENU

Move:

100-0009

Save?
Save
Cancel
Confirm : OK

Rotating an image
■ You can rotate the stored images by various degrees. Once the playback of the rotated
picture is finished, it will switch back to the original state.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Rotate]
menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN
button.

Rotate
Right 90°
Left 90°
180°
Horizontal
Vertical
Exit:MENU

[Right 90˚] :
Rotate picture in a
clock-wise direction

[Left 90˚] :
Rotate picture in a counterclock-wise direction

[Horizontal] :
Rotate picture horizontally

Move:

[180˚] :
Rotate picture 180
degrees

[Vertical] :
Rotate picture vertically

4. Press the OK button and the rotated image will be displayed.
If you display the rotated image on the LCD monitor, empty spaces may appear to the left
and right of the image.

DPOF
■ DPOF(Digital Print Order Format) allows you to embed printing information on your memory
card’s MISC folder. Select the pictures to be printed and how many prints to make.
■ The DPOF indicator will display on the LCD monitor when an image that has DPOF
information plays back. Images can then be printed on DPOF printers, or at an increasing
number of photo labs.
■ This function is not available for Movie clips and Voice recording files.
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DPOF : Standard
■ This function allows you to embed print quantity information on a stored image.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]
menu tab.
3. Select the [Standard] menu by pressing the UP/ DOWN
button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Select] : Selection window for an image to print is
displayed.
- Up/Down/Left/Right : Select an image to print.
- Zoom W/T Button : Select the number of prints.
[All Pics] : Configure number of prints for all pictures
except movie and voice files.
- W/T button : Select a number of prints
[Cancel] : Cancel the print setup.
5. Press the OK button to confirm the setting.
If an image carries DPOF instructions, the DPOF indicator
(
) will show.

DPOF

Standard

Select

Index
Size

All Pics
Cancel

Back:◀

W◀

Set:OK

0 Prints

▶T

Set:OK

W◀

0 Prints

▶T

Set:OK

DPOF : Index
■ Images (except for movie clips and voice file) are printed as index type.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]
menu tab.
3. Select the [Index] menu by pressing the UP/ DOWN button
and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button.
If [No] is selected : Cancel the index print setting.
If [Yes] is selected : The image will be printed in index format.
5. Press the OK button to confirm the setting.
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DPOF
Standard

No

Index

Yes

Size

Back:◀

Set:OK

DPOF : Print size
■ You can specify the print size when printing images stored on the memory card.
The [Size] menu is available only for DPOF 1.1 compatible printers.
● Setting the Print Size
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]
menu tab.
3. Select the [Size] menu by pressing the UP/ DOWN button
and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Select] : Selection window for an image to be changed
printed size is displayed.
- Up/Down/Left/Right : Select an image.
- Zoom W/T Button : Change the print size.
- OK button
: Your changes will be saved and the
menu will disappear.
[All Pics] : Change print size of all saved images.
- W/ T button : Select a print size
- OK button : Confirm the changed setting.
[Cancel] : Cancel all of the print size settings.
※ DPOF [Size] secondary menu : Cancel, 3X5, 4X6, 5X7,
8X10
※ Depending on the manufacturer and print model,
canceling the printing may take a little longer for the printer
to process.

DPOF
Standard
Index

Size

Select
All Pics
Cancel

Back:◀

W◀

Set:OK

Cancel

▶T

Set:OK

W◀

Cancel

▶T

Set:OK
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Copy To Card
■ This enables you to copy image files, movie clips and voice recording files to the memory card.
● Copying to the Memory Card
1. Press the play mode button and press the menu button.
2. Select the [Copy to Card] menu tab by pressing the
Copy To Card
LEFT/ RIGHT button.
No
Yes
3. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
- [No] : Cancels "Copy to Card".
Exit:MENU
Move:
- [Yes] : All images, movie clips and voice recording files
saved in the internal memory are copied to the memory card after the
[Processing!] message is displayed. After copying has been completed, the
screen will return to play mode.

INFORMATION
● When this menu is selected without inserting a memory card, you can select the
[Copy to Card] menu but the menu can’t be run.
● If there is not enough space available in the memory card to copy saved images in the
internal memory (20MB), the [Copy to Card] command will copy only some of the images
and display [Card Full!] message. Then the system will return to the playback mode.
Please be sure to delete any unnecessary files to free up space before inserting the
memory card into the camera.
● When you move the images that are stored in the internal memory by doing [Copy to
Card] to the card, the next number of file names will be created in the card to avoid
duplication of the file name.
- When the [Reset] of the [File] setup menu was set : The copied file names start from
after the last stored file name.
- When the [Series] of the [File] setup menu was set : The copied file names start from
after the last captured file name. After completing [Copy to Card], the last stored image
of the last copied folder is displayed on the LCD monitor.
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On Screen Display information
■ You can check shooting information about the displayed image.
● How to select the type of information you want to see
1. Press the play mode button and press the menu button.
2. Select the [OSD Information] menu tab by pressing the
LEFT/ RIGHT button.
3. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.

OSD Information

Full OSD
Image Information
OSD Off
Save Mode
Exit:MENU

[Full OSD]

[Image information]

[OSD Off]

Move:

[Save mode : LCD off]
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PictBridge
■ You can use the USB cable to connect this camera to a printer that supports PictBridge (sold
separately) and print the stored images directly. TIFF, Movie clips and voice files cannot be
printed. You can set up the following settings from the PictBridge menu.
Images

: Select the pictures to be printed.

PRINTER SETUP

: Setting up printing(Auto Set/Custom Set)

Print

: Printing pictures

DPOF Print

: Printing the DPOF files

Reset

: Initialising the PictBridge functions

● Connecting the Camera to a Printer
1. Press the POWER button to turn on the camera.
Setup
2. In a mode other than Voice Recording mode, press the
Imprint
Computer
MENU button.
Sound
Printer
USB
3. Press the LEFT/ RIGHT button and select [Setup] menu
AF Lamp
tab.
LCD
Back:◀
Set:OK
4. Select [USB] menu by pressing the UP/ DOWN button
and press the RIGHT button.
5. Select [Printer] menu by pressing the UP/ DOWN button
and press the OK button.
6. Press the menu button twice and the menu will disappear.
7. Use the supplied USB cable to connect the camera to the printer as shown below.
8. Turn on the printer to connect the camera to the printer.

※ If you selected [Computer] in Step 5, when you connect the camera to your printer, the Mode
dial lamp(Green) will illuminate and the connection will not be established. In this case,
disconnect the USB cable, and then follow the procedure from Step 2 and onward.
You can also connect to the printer by pressing the Print button (Play mode button).
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PictBridge: Picture Selection
■ Easy printing
When you connect the camera to printer in the Play back
mode, you can print a picture easily.
- Pressing the shutter button : Currently displayed image will
be printed with the printer’s
default setting.
- Pressing the Left/ Right button : Selects a previous/ next
image.
◀

■ Select pictures to print
1. The [Images] menu will appear.
2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
When [One Pic] is selected : The PictBridge function will be
applied only to the picture
currently displayed.
When [All Pics] is selected : The PictBridge function will be
applied to all pictures,
excluding TIFF, movie clips
and voice files.

▶

Print:

Menu:OK

Images
One Pic
All Pics

Exit : MENU

Move:

● Setting the Number of Copies to Print
- Select [One Pic] or [All Pics]. A screen where you can set the number of copies to print will
appear as shown below.
141-0001

▲
0
▼
Prev ◀ ▶ Next
Exit:Shutter

▲
0
▼

Set:OK

[When [One Pic] is selected]

Exit:Shutter

Set:OK

[When [All Pics] is selected]

- Press the Up/ Down button to select the number of prints.
- Use the Left/ Right button to select another picture and select the number of prints for
another picture.
- After setting the number of prints, press the OK button to save.
- Press the Shutter button to return to the menu without setting the number of prints.
- The maximum numbers of prints are 100 and if you select the number over 100, [Out Of
Number] message will display.
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PictBridge : Print Setting
■ AUTO SET
1. Use the LEFT and RIGHT buttons to select the
[Auto Set] menu tab.
2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[No] : [Custom Set] values are kept.
[Yes] : All values in the [Custom Set] are automatically
changed.

Auto Set
No
Yes

Exit : MENU

Move:

■ Custom Set : You can select the Paper Size, Print Format, Paper Type, Print Quality, Date
Print, and File Name Print menus for printed pictures.
1. Use the LEFT and RIGHT buttons to select the
[Custom Set] menu tab.
2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the RIGHT button.
3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.

Custom Set
Size
Layout
Type
Quality
Date

Auto
Auto
Auto
Auto
Auto

Exit : MENU

Move:

● The menus you can set up are as follows:

Size

Sub menu

Function

Menu

Setting the size of the printing paper

Auto, Postcard, Card, 4X6, L, 2L, Letter, A4, A3

Setting the number of pictures to be
Layout
Type

printed on a sheet of paper
Setting the quality of the printing paper

Auto, Full, 1, 2, 4, 8, 9, 16, Index
Auto, Plain, Photo, Fastphoto

Setting the quality of the picture to be
Quality
Date
File Name

Auto, Draft, Normal, Fine
printed
Setting whether to print the date

Auto, Off, On

Setting whether to print the file name

Auto, Off, On

※ Some menu options are not supported in all manufacturer and printer models.
If not supported, the menus are still displayed in the LCD, but are not selectable.
※ If the setting values are not changed in the automatic/ manual setting, the setting values are
automatically kept.
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PictBridge: Printing
■ Printing Pictures
1. Use the LEFT and RIGHT buttons to select the [Print]
menu tab.
2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[Standard] : Print the pictures stored in the memory card
in set numbers. One picture is printed on
one piece of paper.
[Index]
: Print multiple images on one sheet of paper.
3. The screen shown on the right will appear and the picture
will be printed. If no picture is selected, the [No image!]
message will be displayed. Press the Menu/ OK button
while printing to cancel the printing and the [Print] menu
is displayed.

Print
Standard
Index

Exit : MENU

Move:

Now Printing
1/1

Cancel:OK

※Number of pictures in an index print varies depends on the
printer used.
※Depending on the manufacturer and print model, canceling the printing may take a little longer
for the printer to process.
■ DPOF Print : This allows you to directly print the files with DPOF information.
1. Use the LEFT and RIGHT buttons to select the
[DPOF Print] menu tab.
2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[No] : Cancel the printing
[Yes] : Directly print the file with the DPOF information

DPOF Print
No
Yes

Exit : MENU

Move:

※ Depending on the manufacturer and printer model, some menus may not be available.
With a printer without supporting the DPOF, the menu is still displayed but not available.
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PictBridge : RESET
■ Initialises user-changed configurations.
1. Use the LEFT and RIGHT buttons to select the [Reset]
menu tab.
2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
If [No] is selected : Settings will not be reset.
If [Yes] is selected : All print and image settings will be reset.

Reset
No
Yes

Exit : MENU

※ Default print setting varies depending on the printer manufacturer.
For your printer’s default setting, refer to the user’s guide that came with your printer.
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Move:

Setup menu
■ In this mode, you can set up basic settings.
You can use the setup menu in all camera modes, except Voice Recording mode.
The items indicated by
are default settings.
Menu tab

Main menu

Sub menu

Secondary menu

Reset

-

Series

-

Off, 1, 3, 5, 10 min

-

p.94

File
Power Off

Page

ENGLISH

한국어

FRANÇAIS

DEUTSCH

ESPAÑOL

ITALIANO

p.95

日本語
Language

P”CCK»…

PORTUGUÊS

DUTCH

DANSK

SVENSKA

SUOMI

p.96

BAHASA
POLSKI

Magyar

No

-

Yes

-

05/01/01 13:00

Off

yy/mm/dd

-

dd/mm/yy

-

mm/dd/yy

-

Off

-

Date

-

Date & Time

-

Off

-

Low

-

Medium

-

High

-

p.96

Format

Date & Time

Imprint

p.97

p.97

p.98

Sound
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Setup menu
Menu tab

Main menu

Sub menu

Secondary menu

Computer

-

Printer

-

Off

-

On

-

Dark

-

Normal

-

Bright

-

NTSC

-

PAL

-

Off/ 0.5, 1, 3sec

-

No

-

Yes

-

p.98

USB

p.99

AF Lamp

LCD

Video Out
Quick View

Page

p.99

p.100
p.101
p.101

Reset
* Menus are subject to change without prior notice.

File name
■ This function allows the user to select the file naming format.
● Assigning File Names
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
Series
File
2. Press the LEFT/ RIGHT button and select the [Setup]
Reset
Power Save
menu tab.
Language
Format
3. Select the [File] menu by pressing the UP/ DOWN button
Date&Time
and press the RIGHT button.
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Reset]
: After using the reset function, the next file name will be set from 0001 even
after formatting, deleting all or inserting a new memory card.
[Series]
: New files are named using numbers that follow the previous sequence, even
when a new memory card is used, or after formatting, or after deleting all
pictures
5. Press the menu button twice and the menu will disappear.
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File name
INFORMATION
● The first stored folder name is 100SSCAM, and the first file name is SV200001.
● File names are assigned sequentially from SV200001 → SV200002 → ~ → SV209999.
● The folder number is assigned sequentially from 100 to 999 as follows
: 100SSCAM → 101SSCAM → ~ → 999SSCAM.
● The files used with the memory card conform to the DCF(Design rule for Camera File
systems) format.

Auto power off
■ This function switches the camera off after a set amount of time in order to prevent
unnecessary battery drainage.
● Setting Power Off
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
2. Press the LEFT/ RIGHT button and select the [Setup]
Off
File
1 min
Power
Off
menu tab.
Language
3 min
3. Select the [Power Off] menu by pressing the UP/ DOWN
Format
5 min
Date&Time
10 min
button and press the RIGHT button.
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Off]
: The power off function will not operate.
[1, 3, 5, 10min] : The power will turn off automatically if not used for the period of time
specified.
5. Press the menu button twice and the menu will disappear.

INFORMATION
● Even if the batteries or AC adapter are removed and inserted again, the power off setting
will be preserved.
● Note that the automatic power off function will not operate if the camera is in PC mode, slide
show, playing back a voice recording, playing back a movie clip or during composite shooting.
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Language
■ There is a choice of languages that can be displayed on the LCD monitor. Even if the batteries or
AC adapter are removed and inserted again, the language setting will be preserved.
● Setting Language
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
2. Press the LEFT/ RIGHT button and select the [Setup]
File
ENGLISH
Power Off
menu tab.
한국어
Language
FRANÇAIS
3. Select the [Language] menu by pressing the UP/ DOWN
DEUTSCH
Format
button and press the RIGHT button.
ESPAÑOL
Date&Time
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
LANGUAGE sub menu : English, Korean, French, German, Spanish, Italian, S.Chinese,
T.Chinese, Japanese, Russian, Portuguese, Dutch, Danish, Swedish, Finnish, Thai,
BAHASA(MALAY/ INDONESIAN), Arabic, Hungarian, Czech and Polish.
5. Press the menu button twice and the menu will disappear.

Formatting a memory card
■ This is used for formatting the memory card. If you run [Format] on the memory card, all
images, including the protected images, will be deleted. Be sure to download important
images to your PC before formatting the memory card.
● Formatting a Memory Card
1. In any mode other than Voice Recording mode, press the
MENU button.
Setup
2. Press the LEFT/ RIGHT button and select the [Setup]
File
No
Power Off
Yes
menu tab.
Language
3. Select the [Format] menu by pressing the UP/ DOWN
Format
Date&Time
button and press the RIGHT button.
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
If [No] is selected : The memory card will not be formatted.
Press the menu button twice and the menu display will disappear.
If [Yes] is selected : A [Processing!] message appears and the memory card will be
formatted. If you ran FORMAT in Play mode, a [No Image !]
message will appear.

INFORMATION
● Be sure to run [Format] on the following types of memory card.
- A new memory card, or an unformatted memory card.
- A memory card that has a file this camera can't recognise or one that has been taken
from another camera.
● Always format the memory card using this camera. If you insert a memory card that has
been formatted using other cameras, memory card readers, or PCs, you will get a
[Card Error!] message.
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Setting up the Date/ Time/ Date type
■ You can change the date and time that will be displayed on the captured images and set up
the date type.
● Setting Date/Time & Selecting Date Format
1. In any mode with the exception of Voice Recording mode,
Setup
▲
File
press the MENU button.
05/ 08/ 01
Power Off
▼
2. Press the LEFT/ RIGHT button and select the [Setup]
Language
13:01
Format
menu tab.
yy/mm/dd
Date&Time
3. Select the [Date&Time] menu by pressing the UP/ DOWN
Back:◀
Set:OK
button and press the RIGHT button.
4. Use the UP, DOWN, LEFT, and RIGHT buttons to select
the desired submenu value, and then press the OK button.
RIGHT button : Selects the year/month / day/hour / minute date type.
LEFT button : Moves the cursor to the [Date&Time] main menu if the cursor is at the first
item of the date and time setup. In all other cases, the cursor will be shifted
to the left of its current position.
UP and DOWN buttons : Changes the setting value.
- Date type : [yy/mm/dd] /[dd/mm/yy] /[mm/dd/yy] /[Off]
5. Press the menu button twice and the menu will disappear.

Imprinting the recording date
■ There is an option to include DATE/TIME on still images.
● Date Imprinting
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
2. Press the LEFT/ RIGHT button and select the [Setup]
Power Off
Off
Language
Date
menu tab.
Format
Date&Time
Date&Time
3. Select the [Imprint] menu by pressing the UP/ DOWN
Imprint
button and press the RIGHT button.
Back:◀
Set:OK
4. Use the UP and DOWN buttons to select the desired date
imprint type, and then press the OK button.
[Off]
: The DATE & TIME will not be imprinted on the image file.
[Date]
: Only the DATE will be imprinted on the image file.
[Date&Time] : The DATE & TIME will be imprinted on the image file.
5. Press the menu button twice and the menu will disappear.
* The Date & Time are imprinted at the bottom right side of the still image.
* The date will be imprinted as a DATE TYPE setting.
* TIME is imprinted in the following way : [Hour : Minute] and hours are shown using the 24
hour clock.
* The imprint function is applied only to still images except for the images taken in the [Text]
scene mode and photo frame effect mode.
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Sound
■ If you set the operation sound to ON, various sounds will be activated for camera startup,
when button are pressed, and if there is a card error, so that you can be aware of the camera
operation status.
● Setting Operation Sounds
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]
menu tab.
3. Select the [Sound] menu by pressing the UP/ DOWN
button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Sound] sub menu : Off/ Low/ Medium/ High
5. Press the menu button twice and the menu will disappear.

Language
Format
Date&Time
Imprint

Sound
Back:◀

Setup
Off
Low

Medium
High
Set:OK

Connecting an External Device (USB)
■ You can select an external device to which you want to connect the camera using the USB
cable.
● Selecting an External Device
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
Format
Computer
2. Press the LEFT/ RIGHT button and select the [Setup]
Date&Time
Printer
menu tab.
Imprint
Sound
3. Select the [USB] menu by pressing the UP/ DOWN button
USB
and press the RIGHT button.
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Computer] : Select this if you want to connect the camera to your PC.
Refer to page 124 for instructions on how to connect the camera to your PC.
[Printer]
: Select this if you want to connect the camera to your printer.
Refer to page 88 for instructions on how to connect the camera to your
printer.
5. Press the menu button twice and the menu will disappear.
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Auto Focus lamp
■ You can turn on and off the Auto Focus lamp
● How to set up the lamp
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
2. Press the LEFT/ RIGHT button and select the [Setup]
Off
Date&Time
Imprint
On
menu tab.
Sound
USB
3. Select the [AF Lamp] menu by pressing the UP/ DOWN
AF Lamp
button and press the RIGHT button.
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
If [Off] is selected : The AF lamp will not light up.
If [On] is selected : The AF lamp will light up.
※ If you select [Off] menu and take an image in poorly lit condition or select the [Night]
scene mode, the camera may not take exact focus.
※ The Auto Focus lamp will function while using the self-timer even if the configuration is set
to off the lamp.

LCD brightness
■ You can adjust the LCD brightness.
● Adjusting LCD Brightness
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]
menu tab.
3. Select the [LCD] menu by pressing the UP/ DOWN button
and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[LCD] sub menu : Dark, Normal, Bright
5. Press the menu button twice and the menu will disappear.

Imprint
Sound
USB
AF Lamp

Setup
Dark

Normal
Bright

LCD
Back:◀

Set:OK
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Selecting Video out type
■ The Video output signal from the camera can be NTSC or PAL.
Your choice of output will be governed by the type of device (monitor or TV, etc.) to which the
camera is connected. PAL mode can support only BDGHI.
● Setting the Video Out Type
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]
menu tab.
3. Select the [Video Out] menu by pressing the UP/ DOWN
button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[Video Out] sub menu : NTSC, PAL
5. Press the menu button twice and the menu will disappear.

Setup
Sound
USB
AF Lamp
LCD

NTSC
PAL

Video Out
Back:◀

Set:OK

● Connecting to an external monitor
In RECORDING/ PLAY mode, you can
view the stored still images or movie clips
by connecting the camera to an external
monitor via the AV cable. When the
camera is connected to an external
monitor, the LCD monitor will be turned
off automatically.
Yellow Colour-Video
White Colour-Voice

INFORMATION
● NTSC : U.S.A, Canada, Japan, South Korea, Taiwan, Mexico.
● PAL : Australia, Austria, Belgium, China, Denmark, Finland, Germany, U.K., Holland,
Italy, Kuwait, Malaysia, New Zealand, Singapore, Spain, Sweden, Switzerland,
Thailand, Norway.
● When using a TV as an external monitor, you will need to select the external or AV
channel of the TV.
● There will be a digital noise on the external monitor, but it is not a malfunction.
● If the image is not in the centre of the screen, use the TV controls to centre it.
● When the camera is connected to an external monitor, the menu will be visible on the
external monitor and the menu functions are the same as those indicated on the LCD
monitor.
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Quick view
■ If you enable Quick View before capturing an image, you can view the image you just
captured on the LCD monitor for the duration set in the [Quick View] setup. Quick view is
possible only with still images.
● Setting Quick View
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
USB
2. Press the LEFT/ RIGHT button and select the [Setup]
Off
AF Lamp
0.5 sec
menu tab.
LCD
1 sec
Video
Out
3 sec
3. Select the [Quick View] menu by pressing the UP/ DOWN
Quick View
button and press the RIGHT button.
Back:◀
Set:OK
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
[off]
: The quick view function can’t be activated.
[0.5, 1, 3sec] : The captured image is briefly displayed during the selected time.
5. Press the menu button twice and the menu will disappear.

Initialisation
■ All camera menu and function settings will be restored to their default values.
However, values for DATE/ TIME, LANGUAGE, and VIDEO OUT will not be changed.
● Initialising the Camera
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
Setup
2. Press the LEFT/ RIGHT button and select the [Setup]
AF Lamp
No
LCD
Yes
menu tab.
Video Out
Quick View
3. Select the [Reset] menu by pressing the UP/ DOWN
Reset
button and press the RIGHT button.
Back:◀
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
If [No] is selected
: Settings will not be restored to their defaults.
If [Yes] is selected : All settings will be restored to their defaults.

Set:OK
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Setting up the MYCAM menu
■ You can set up a start up image, start up sound and shutter sound. Every camera working
mode (with the exception of Voice recording mode) has the MyCAM menu.
The items indicated by
are default settings.
Menu tab

Main menu

Sub menu

Page

Off

LOGO

User Image 1

User Image 2

Off

Sound 1

Sound 2

Sound 3

Off

Sound 1

Sound 2

Sound 3

Start Image

p.102

p.103

Start Sound

Shutter Sound

p.103

* Menus are subject to change without prior notice.

Start up image
■ You can select the image that is first displayed on the LCD monitor whenever the camera is
turned on.
● Setting a Startup Image
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]
menu tab.
3. Select the [Start Image] menu by pressing the UP/ DOWN
button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Mycam

Start Image
Start Sound
Shutter Sound

Back:◀

Set:OK

INFORMATION
● Use a saved image for the start-up image with the [User Image] in the [Resize] menu in
the play mode.
● The start-up image will not be deleted by deleting all images or [Format] menu.
● The User images will be deleted by [Reset] menu.
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Start up sound
■ You can select the sound that is activated whenever the camera is turned on.
● Setting the Startup Sound
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]
menu tab.
3. Select the [Start Sound] menu by pressing the UP/
DOWN button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Mycam
Start Image

Off

Start Sound

Sound1
Sound2
Sound3

Shutter Sound

Back:◀

Set:OK

Shutter sound
■ You can select the shutter sound.
● Selecting the Shutter Sound
1. In any mode with the exception of Voice Recording mode,
press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]
menu tab.
3. Select the [Shutter Sound] menu by pressing the UP/
DOWN button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN
button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Mycam
Start Image
Off
Start Sound
Sound1

Shutter Sound

Back:◀

Sound2
Sound3
Set:OK

INFORMATION
● If the start up image is set to [Off], the start up sound will not acticate, even though you
may have set these to on.
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Important notes
Be sure to observe the following precautions!
■ This unit contains precision electronic components. Do not use or store this unit in the
following locations.
- Areas exposed to severe changes in temperature and humidity.
- Areas exposed to dust and dirt.
- Areas exposed to direct sunlight or the inside of a vehicle in hot weather.
- Environments where there is high magnetism or excessive vibration.
- Areas with high explosives or highly flammable materials.
■ Do not leave this camera in places subject to dust, chemicals (like naphthalene and
mothball), high temperature and high humidity.
Keep this camera with silica gel in a hermetically sealed box when not planning to use the
camera for a long period of time

■ Sand can be particularly troublesome to cameras.
- Do not let sand get inside the unit when using it on beaches, coastal dunes, or other areas
where there is lots of sand.
- Doing so may result in failure or may permanently render the unit unusable.
■ Handling the camera
- Never drop the camera or subject it to severe shocks or vibrations.
- Prevent the large size LCD monitor from an impact. When this camera is not used, keep
this camera in the camera case.
- Avoid obstructing the lens or the flash when you capture an image.
- This camera is not waterproof.
To avoid dangerous electrical shocks, never hold or operate the camera with wet hands.
- If you use this camera in wet places, such as beach or pool, do not let water or sand get
inside the camera. Doing so may result in failure or may permanently damage the unit.
■ Extremes in temperature may cause problems.
- If the camera is transferred from a cold to a warm and humid environment, condensation
can form on the delicate electronic circuitry. If this occurs, turn the camera off and wait for at
least 1 hour until all moisture is dispersed. Moisture build up can also occur in the memory
card. If this happens, turn off the camera and remove the memory card. Wait until the
moisture has dispersed.
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Important notes
■ Caution on Using the Lens
- If the lens is subjected to direct sunlight, it could result in discoloration and deterioration of
the image sensor.
- Pay attention not to get fingerprints or foreign substances on the surface of the lens.
■ If the digital camera is not used for a long period, an electric discharge can occur.
It is a good idea to remove the batteries and the memory card if you do not intend using the
camera for an extended period of time.
■ If the camera is exposed to an electronic interference, it will turn itself off to protect the
memory card.
■ Camera Maintenance
- Use a soft brush (available from photo stores) to gently clean the lens and LCD assemblies.
If this does not work, lens-cleaning paper with lens cleaning fluid can be used.
Clean the camera body with a soft cloth. Do not allow this camera to come into contact with
solvent materials such as benzol, insecticide, thinners etc. This may damage the body shell
of the camera and also affect its performance. Rough handling can damage the LCD
monitor. Take care to avoid damage and keep the camera in its protective carry case at all
times when not in use.
■ Do not attempt to disassemble or modify the camera.
■ Under certain conditions, static electricity can cause the flash unit to fire. This is not harmful to
the camera and is not a malfunction.
■ When images are uploaded or downloaded(when the charger and USB cable are inserted
into the cradle at the same time), the data transfer may be affected by static electricity.
In this case, disconnect and re-connect the USB cable before trying the transfer again.
■ Before an important event or going on a trip, you should check the camera condition.
- Take a picture for testing the camera condition and prepare extra battery.
- Samsung cannot be held responsible for camera malfunctions.
■ Do not use headphones/earphones while driving, cycling, or operating any motorized vehicle.
It may create a traffic hazard and can be illegal in some areas.
■ Avoid using headphones/earphones at high volume. Hearing experts advise against
continuously loud and extended play. If you experience a ringing in your ears, reduce volume
or discontinue use.
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Warning indicator
■ There are several warnings that may appear on the LCD display.

Card Error !
ㆍMemory card error
→ Turn off the camera power and turn it on again
→ Insert the memory card again
→ Insert the memory card and format the memory card (p.96)
No Card !
ㆍThe camera can’t recognise the memory card
→ Insert the memory card again
→ Turn off the camera power and turn it on again
Card Locked !
ㆍThe memory card is locked
→ SD memory card : Slide the write protect switch to the top of the memory card
Card Full !
ㆍThere is insufficient memory capacity to take an image
→ Insert a new memory card
→ Delete unnecessary image files to free up some memory
No Image !
ㆍThere are no images stored on the memory card
→ Take images
→ Insert a memory card that is holding some images
File Error !
ㆍFile error
→ Format the memory card
ㆍMemory card error
→ Contact a camera service centre
Low Battery !
ㆍThere is low battery capacity
→ Insert charged battery
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Warning indicator
Low Light !
ㆍWhen taking pictures in dark places
→ Use a tripod and take pictures in Flash Photography mode
Out Of Number
ㆍWhen selecting too many printing pages in the PictBridge menu.
→ Select printing page within the limitation.

Before contacting a service centre
■ Please check the following
The camera doesn’t switch on
ㆍThere is low battery capacity.
→ Insert charged battery.
ㆍBatteries are inserted incorrectly with the reverse polarities.
→ Insert the batteries according to the polarity marks (+, -).
ㆍThe rechargeable battery is not inserted
→ Insert the battery and turn on the camera
The camera power ceases while in use.
ㆍThe batteries are exhausted.
→ Insert charged battery.
ㆍThe Camera is turned off automatically.
→ Turn off the camera power and turn it on again.
Batteries drain quickly
ㆍThe Camera is being used in low temperatures.
→ Keep the camera in warm conditions (i.e. inside a coat or jacket) and only remove it in
order to take images.
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Before contacting a service centre
Camera does not take images when pressing the Shutter button
ㆍThere is insufficient memory capacity.
→ Delete unnecessary image files
ㆍThe memory card has not been formatted
→ Format the memory card (p.96)
ㆍThe memory card is exhausted
→ Insert a new memory card
ㆍThe memory card is locked
→ Refer to [Card Locked !] error message (p.106)
ㆍThe camera’s power is off
→ Turn the camera power on
ㆍThe batteries are exhausted
→ Insert charged battery.
ㆍBatteries are inserted incorrectly with the reverse polarities.
→ Insert the batteries according to the polarity marks (+, -).
The camera suddenly stops working while in use
ㆍThe camera was stopped due to a malfunction
→ Remove /re-insert batteries and switch the camera on
The images are unclear
ㆍA picture was taken within 0.8 m from the subject without setting an appropriate macro mode
→ If the subject is closer than 0.8m, select macro shot mode
ㆍTaking a picture beyond the flash range
→ Take a picture within the flash range
ㆍThe lens is smudged or dirty
→ Clean the lens
The flash does not fire
ㆍFlash off mode has been selected
→ Dis-engage flash off mode
ㆍThe camera mode can’t use the flash
→ Refer to the FLASH instruction (p.33)
Incorrect date and time is displayed
ㆍThe date and time have been set incorrectly or the camera has adopted the default settings
→ Reset the date and time correctly
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Before contacting a service centre
The images don't play back
ㆍIncorrect file name (Violation of DCF format)
→ Do not change the image file name
Colour of image is different to the original scene
ㆍWhite balance setting is incorrect
→ Select appropriate White balance
Images are too bright
ㆍExposure is excessive
→ Reset exposure compensation
No image on external monitor
ㆍThe external monitor has not been connected properly with the camera
→ Check the connection cables
ㆍThere are incorrect files in the memory card
→ Insert a memory card that has correct files
When using the PC’s explorer, the [Removable Disk] file does not show
ㆍCable connection is incorrect
→ Check the connection
ㆍThe camera is off
→ Turn the camera on
ㆍThe operating system is not Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3.
Alternatively the PC does not support USB
→ Install Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3 to PC that supports USB
ㆍThe camera driver is not installed
→ Install a [USB Storage Driver]
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Specifications
Type
Effective Pixel
Total Pixel

Image Sensor

Focal Length
Lens

F No.
Digital Zoom

Viewfinder

Focusing

LCD Monitor
Type
Range
Type

Shutter

Speed

Control
Exposure
Compensation
ISO Equivalent
Modes
Flash

Range
Recharging Time

Sharpness
Effect
White Balance
Voice Recording
Date Imprinting

Still Image
Shooting

Movie Clip
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1/1.8" CCD
Approx. 8.1 Mega-pixel
Approx. 8.4 Mega-pixel
Schneider Lens f = 7.8 ~ 23.4 mm
(35mm film equivalent : 38 ~ 114 mm)
F2.8 ~ F5.1
Still Image mode : 1.0X ~ 10.0X
Play mode : 1.0X ~ 12.75X (depends on image size)
2.5" Colour TFT LCD (230,000 dots)
TTL auto focus, Manual focus
Normal : 80cm ~ infinity
Macro : 4 ~ 80cm (Wide), 25 ~ 80cm (Tele)
Auto Macro : 4cm ~ infinity (Wide), 25 ~ infinity (Tele)
Mechanical and Electronic shutter
Auto : 1 ~ 1/2,000 sec.
Manual : 15 ~ 1/2,000 sec.
Night : 8 ~ 1/2,000 sec. Fireworks : 4 ~ 1/2,000 sec.
Program AE, Shutter Priority AE, Aperture Priority AE or
Manual Exposure
Metering : Multi, Spot
±2.0EV (1/3EV steps)
Auto, 50, 100, 200, 400
Auto, Auto & Red-eye reduction,
Slow sync, Fill-in, Off
Wide : 0.2 ~ 3.0m, Tele : 0.25 ~ 2.0m
Approx. 7 sec.
Soft, Normal, Vivid
Normal, B&W, Sepia, Negative. Red, Green, Blue
Auto, Daylight, Cloudy, Fluorescent_H, Fluorescent_L,
Tungsten, Custom1, Custom 2
Voice Recording (max. 1 hour)
Voice Memo in Still Image (max. 10 sec.)
Date&Time, Date, Off (user selectable)
Modes : Auto, Program, A, S, M, MySET, Scene
* Scene : Night, Portrait, Children, Landscape, Close-up,
Text, Sunset, Dawn, Backlight, Fireworks,
Beach/Snow
Shooting : Single, Continuous, AEB, AFB
Self-timer : 2 sec., 10 sec., Double, Remote control
With audio (recording time : memory capacity dependent)
Size : 640x480, 320x240, 160x128
Frame rate : 30 fps, 15 fps

Specifications
Media
File Format

Image Size

Storage

Capacity
(32MB)

Image Play

Type
Editing

Interface

Power Source
Dimensions (W x H x D)
Weight
Operating Temperature
Operating Humidity
Camera Driver
Software
Application

Special Features

Internal 20MB, SD/ MMC Card (up to 1GB guaranteed)
Still Image : JPEG (DCF), EXIF 2.2, DPOF 1.1, PictBridge 1.0
Movie Clip : AVI (MPEG-4)
Audio : WAV
3264 : 3264x2448, 3072 : 3072x2304,
2816 : 2816x2112, 2592 : 2592x1944,
2272 : 2272x1704, 2048 : 2048x1536,
1600 : 1600x1200, 1024 : 1024x768,
640 : 640x480
3264 : Super Fine 7 Fine 13 Normal 19 TIFF 1
3072 : Super Fine 7 Fine 15 Normal 23 TIFF 1
2816 : Super Fine 9 Fine 18 Normal 26 TIFF 1
2592 : Super Fine 10 Fine 21 Normal 31 TIFF 1
2272 : Super Fine 14 Fine 26 Normal 33 TIFF 2
2048 : Super Fine 17 Fine 33 Normal 47 TIFF 3
1600 : Super Fine 28 Fine 51 Normal 62 TIFF 4
1024 : Super Fine 60 Fine 106 Normal 129 TIFF 11
640 : Super Fine 121 Fine 139 Normal 165 TIFF 22
* These figures are measured under Samsung’s standard conditions
and may vary depending on shooting conditions and camera settings.
Single image, Thumbnails, Slide show, Album organisation, Movie clip
Trimming, Resizing, Rotating
Digital output connector : USB 2.0 Audio : Mono
Video output : NTSC, PAL (user selectable)
DC power input connector : 3.3V
Rechargeable battery : Li-ion SLB-1137 (3.7V, 1,130mAh)
AC Adapter : SAC - 32(DC 3.3V, 2.0A)
106 x 56.4 x 30.5 mm (excluding the projecting parts of the camera)
Approx. 162g (without batteries and card)
0 ~ 40˚C
5 ~ 85%
Storage Driver (Windows98/98SE/2000/ME/XP, Mac OS 9.2 ~ 10.3)
Digimax Master, Digimax Reader
MPEG-4, VGA 30fps Movie Clip
Movie Clip Stabilizer and Movie Edit on DSC
Successive Movie Recording
World’s renowned Schneider Lens
Powerful Manual : A, S, M
Convert Scanned Text Images into Editable Document
Integrated S/W : Movie Maker and Movie Converter

* Specifications are subject to change without prior notice.
* All trademarks are the property of their respective owners.

《111》

Software Notes
Please ensure that you read the instruction manual carefully before use.
ㆍThe attached software is a camera driver and image editing software tool for Windows.
ㆍUnder no circumstances should all or part of either the software or the user manual be
reproduced.
ㆍCopyrights for software are licensed only for use with a camera.
ㆍIn the unlikely event of a manufacturing fault, we will repair or exchange your camera.
We cannot, however, be held responsible in any way for damage caused by inappropriate
use.
ㆍUsing a Hand-made PC or a PC and OS that has not been guaranteed by the manufacturer is
not covered by the Samsung warranty.
ㆍBefore reading this manual, you should have a basic knowledge of computers and O/S
(Operating Systems).

System Requirements
For Windows
PC with processor better than Pentium II 450Mz

For Macintosh
Power Mac G3 or later

(Pentium 700MHz recommended)
Windows 98/98SE/2000/ME/XP

Mac OS 9.2 ~ 10.3

Minimum 64MB RAM (XP : 128MB)

Minimum 64MB RAM

200MB of available hard disk space

110MB of available hard-disk space

(1GB recommended)
USB port

USB port

CD-ROM drive

CD-ROM drive

1024x768 pixels, 16-bit colour display

QuickTime player

compatible monitor (24-bit color display

DivX(for movie clip)

recommended)
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About the software
After inserting the CD-ROM provided with this camera into the CD-ROM drive, the following
window should automatically run.
Before connecting the camera to the PC,
you should first install the camera driver.

■ Camera driver : This enables images to transfer between the camera and PC.
This camera uses the USB Storage Driver as the camera driver. You can use the camera as
a USB card reader. After installing the driver and connecting this camera to the PC, you can
find [Removable Disk] in [Windows Explorer] or [My computer]. A USB Storage Driver is
provided only for Windows. A USB Driver for MAC is not included with the Application CD.
You can use the camera with Mac OS 9.2 ~ 10.3.

■ XviD codec : This makes movie clips(MPEG-4) recorded with this camera play back on
a PC.
To play back a movie clip recorded with this camera, you must install the XviD codec.
If a movie clip recorded with this camera does not play well, install this codec.
This software is only compatible with Windows.
If a movie clip can’t play back on the Mac OS, please visit the following site.
http://www.divx.com/divx/mac/
If a movie clip can’t play back on the Mac OS, use a media player that supports XviD codec
(Mplayer, VideoLanClient)

■ Digimax Master : This is the all-in-on multi media software solution.
You can download, view, edit and save your digital images and movie clips clip with this
software. This software is only compatible with Windows.
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About the software
■ Digimax Reader : Text recognition program.
You can save an image file that was captured in the TEXT mode as a text file with this
program. This software is only compatible with Windows.

INFORMATION
● Be sure to check the system requirements before installing the driver.
● You should allow 5 ~ 10 seconds for running the automatic setup program according to
the capability of your computer. If the frame does not show, run the [Windows Explorer]
and select [Samsung.exe] in the CD-ROM Drive root directory.
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Setting up the application software
To use this camera with a PC, install the application software first.
After this has been done, the stored images in the camera can be moved to the PC and can be
edited by an image editing program.

INFORMATION
● Close other programs before installing the application software.
● Before installing the application software, disconnect the USB connection.

You can visit the Samsung web-site through the internet.
http://www.samsungcamera.com : English
http://www.samsungcamera.co.kr : Korean

1. Click the [Install] menu in the Auto run frame.
The camera driver is installed automatically.

[Click !]

2. Installation is complete.
Click the [Finish] button.

[Click !]

3. The Software License Agreement window for
DirectX will be displayed. If you agree to this,
select [I accept the agreement] and click [Next >]
button. the window will then move to the next step.
If you disagree, select [I do not accept the
agreement] and click [Cancel] button.
The installation program will be cancelled.

[Click !]
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Setting up the application software
4. A window will open. Click the [Next(N) >] button.

[Click !]

5. DirectX Installation is completed.
Click the [Finish] button and then the Xvid
codec installation will be started.
* The system will not reboot even if you click
the [Finish] button.
* The screen shot of step 5 can be different
from the illustration depending on the system [Click !]
requirements.

6. A windows to check whether the PC has XviD codec or not
will display.
[Preview] : You can check the movie clip display
condition.
[Install]
: The XviD codec is installed.
[Cancel] : The XviD codec is not installed and a window
for installing the application softwares will
display.
※ If you didn’t click the [Preview] button, the [Install] button can’t be selected.
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[Click !]

Setting up the application software
7. If an error listed below takes place during the preview,
click the [Install] button to install the XviD codec.
- Only a voice plays back.
- An error message displays and the movie clip does not
play back.

* A window shown alongside may display according
to the system requirements.
[Click !]

8. The XviD codec installation window will be displayed
as shown alongside. Click the [Next >] button.

[Click !]

9. The Software License Agreement window will be
displayed. If you agree to this, select [I accept the
agreement] and click [Next >] button.
The window will then move to the next step.
If you disagree, select [I do not accept the agreement]
and click [Cancel] button. The installation program will
be cancelled.
※ The XviD codec is distributed according to the GNU
[Click !]
General Public License and everyone can copy,
distribute and change this codec. For more information, see the License documents.
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Setting up the application software
10. The XviD information window will display.
Click the [Next >] button.

[Click !]

11. The destination selection window will open.
Click [Next >] button.
To copy to the files to another folder, click [Browse...]
and choose a folder you want.

[Click !]

12. A window will open, asking you to choose a folder to
which program icons will be added.
Click [Next >] button.
If you want to add the program icons to a different folder,
choose another folder, and then click [Next >] button.

[Click !]

13. The [Select Additional Tasks] window will display.
Select the additional tasks and click the [Next >] button.

[Click !]
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Setting up the application software
14. The XviD codec is ready to install.
Click the [Install] button.

[Click !]

15. Installation is complete.
Click the [Finish] button.

[Click !]

16. A window where you can choose the program you want
to install will appear. Click [Install].
For information on application software, please refer to
page 113~114.
[Click !]

INFORMATION
● If you select [Exit] at step 16, the application program installation will be cancelled.

17. The Digimax Master installation window will be displayed
as shown alongside. Click the [Next >] button.

[Click !]
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Setting up the application software
INFORMATION
● If you select [Cancel] at step 17, a window for installing Digimax Reader will be displayed.

18. A window will open. Click the [Next >] button.

[Click !]

19. A destination selection window will open. Click [Next >].
To copy the files to another folder, click [Browse..]
and choose a folder you want.

[Click !]

20. A window will open, asking you to choose a folder to
which program icons will be added. Click [Next >] button.
If you want to choose another folder, click [Browse..] and
choose a folder you want.

[Click !]

21. Click [Install(I)] button and Digimax Master starts installing.

[Click !]
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Setting up the application software
22. Digimax Master installation is successfully completed.
Click the [Finish] button to install Digimax Reader.
* The screen shot of step 22 can be different from the
illustration depending on the system requirements.

[Click !]

23. A window will be displayed as shown alongside.
Click the [INSTALL] button.
- If you click the [Manual] button, instructions for using
Digimax reader will be displayed.
- Click the [EXIT] button and the Digimax reader
installation will be cancelled and a window for
restarting the computer will appear.

[Click !]

24. A window will open. Click the [Next >] button.

[Click !]

25. The Software License Agreement window will be
displayed. If you agree to this, click [Yes],
the window will then move to the next step.
If you disagree, click [No] and the installation program
will be cancelled.

[Click !]
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Setting up the application software
26. A destination selection window will open.
Click the [Next >] button.
To copy the files to another folder, click
[Browse...] and choose a folder you want.

[Click !]

27. Digimax Reader Installation is completed.
The system will not reboot even if the [Yes, I
want to restart the computer now] option is
selected.
※ The screen shot of step 27 can be different
from the illustration depending on the system
requirements.

[Click !]

28. To apply changes, you must restart the computer.
Select [Yes, I want to restart my computer now], and
then click the [OK] button.

[Click !]

29. After restarting the computer, connect the PC to the camera with the USB cable.

30. Turn the camera power on.
The [Found New Hardware Wizard] will open and
the computer will recognise the camera.
* If your OS is Windows XP, an image viewer
program will open.
If the download window of Digmax Master opens
after starting Digimax Master, the camera driver was
setup successfully.
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Setting up the application software
31. If you can see [Removable Disk] under [My computer],
the camera driver installation was successful.
Now you can transfer image files from the camera to
PC via the USB cable.

INFORMATION
● If you have installed the camera driver, The [Found New Hardware Wizard] may not
open.
● On a Windows 98 or 98 SE system, the Found New Hardware Wizard dialog box opens
and a window asking you to select a driver file may appear. In this case, specify "USB
Driver" in the CD supplied. (for Windows 98 and 98 SE).
● Before connecting the camera to the PC, You should first install the camera driver.
● After installing the camera driver, you have to restart your PC.
● If you connect the camera to the PC before installing the camera driver, the [Found New
Hardware Wizard] will open.
In this case, cancel the [Found New Hardware Wizard] and disconnect the camera.
Install the camera driver and connect the camera to the PC again.
● Should the computer not find the camera driver after installation, please try one or more of
the following measures.
1. Delete the camera driver (p.127~128), and re-install the driver.
2. Refer to FAQ (p.140) to check for a possible solution to the problem.
3. If your PC’s central processing unit is VIA chip (This is shown in the USB Host
Controller), download the patch file from the Samsung Camera web page.
(http://www.samsungcamera.com)
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Starting PC mode
• If you connect the USB cable to a USB port on your PC and then turn on the power, the
camera will automatically switch to "computer connection mode".
• In this mode, you can download stored images to your PC through the USB cable.
• The LCD monitor is always turned off in PC mode.
• The camera status lamp will blink when the files are transferring via the USB connection.
■ Connecting the camera to a PC
1. Turn the PC power on.
2. Turn the camera power on.
Setup
3. In any mode other than Voice Recording mode, press
Format
Computer
Date&Time
Printer
the MENU button.
Imprint
Sound
4. Press the LEFT/ RIGHT button and select the [Setup]
USB
menu tab.
Back:◀
Set:OK
5. Select the [USB] menu by pressing the UP/ DOWN
button and press the RIGHT button.
6. Use the UP and DOWN buttons to select [Computer], and then press the OK button.
7. Press the menu button twice and the menu will disappear.
8. Connect the PC and the camera via the USB cable.
- Insert the small plug of the USB cable into the camera USB connection terminal.
- Insert the large connector of the USB cable into the USB port of the PC.
- The plugs must be firmly inserted.

※ If you selected [Printer] in Step 6, when you
connect the camera to your computer, the
[Connecting Printer] message will be
displayed on the LCD monitor and the
connection will not be established. In this
case, disconnect the USB cable, and then
follow the procedure from Step 2 and
onward.

■ Disconnecting the camera and PC : Refer to page 130 (Removing the removable disk).

INFORMATION
● The camera driver must be installed before using PC mode.
● To save battery power, it is recommended that you use an AC adapter (Optional) when
connecting the camera to a computer.

《124》

Starting PC mode
■ Downloading stored images
You can download the still images stored on the camera to your PC's hard disk and print
them or use a photo editing software to edit them.
1. Connect the camera to your PC with the USB cable.

2. On your computer's desktop display, select
[My computer] and double click [Removable Disk
→ DCIM → 100SSCAM].
The image files will then be displayed.

3. Select an image and press the right mouse button.

4. A pop-up menu will open.
Click the [Cut] or [Copy] menu.
- [Cut] : cuts a selected file.
- [Copy] : copies files.

5. Click a folder where you want to paste the file.
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Starting PC mode
6. Press the right mouse button and a pop-up menu
will open. Click [Paste].

7. An image file is transferred from the camera to
your PC.

- By using [Digimax Master], you can see the stored images in the memory directly on the
PC monitor and you can copy or move the image files.
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Removing the USB Driver for Windows 98SE
■ To remove the USB driver, refer to the process shown below.
1. Click [Start → Settings] and click [Control Panel].

2. Double-click [System].

3. Select [Device manager → Hard Disk Controller →
Samsung Digital Camera] and click the [Delete]
button.

[Click !]

4. Click the [OK] button.
The camera is removed from the system.

《127》

Removing the USB Driver for Windows 98SE
5. Click [Start → Settings → Control Panel] and
double click [Add/Remove programs].

6. The [Add/Remove Programs Properties] window
will open. Click [Digimax V800] and click the
[Add/Remove] button.

[Click !]

7. Uninstallation is complete. Click the [Finish] button
and the window will disappear.

[Click !]
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Removable Disk
■ To use this camera as a Removable Disk, install (p.115) the USB Driver.
1. Before turning the camera power on, connect the camera to the PC with the USB cable.
2. Click [Removable Disk] under [My computer] or [Windows Explorer].
3. Image files stored in the Removable Disk (DCIM → 100SSCAM) can be transferred to the
PC.

INFORMATION
Important information whilst using the Removable Disk
● The [Removable Disk] indicator will not show when the camera power is off or the USB
cable is removed.
● We recommend that you should copy the images to the PC to view them. Opening
images directly from the removable disk may be subject to unexpected disconnection.
● When uploading images from the PC to the camera, ensure that the uploaded file names
are not the same as those already stored on the memory.
● When you upload a file that is not taken by this camera to the Removable Disk, the [File
Error!] message will be displayed on the LCD monitor in the PLAY mode, and nothing is
displayed in THUMBNAIL mode.
● The camera status lamp will blink, when a file is
transferred (copy or deletion) between the PC and
the camera. Do not remove the USB cable until the
lamp stops blinking.
100-0009
0-0009
To remove the USB cable in Windows
2000/ME/XP, use the [Unplug or Eject Hardware]
icon on the task bar.
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Removing the removable disk
■ Windows 98SE
1. Check whether the camera and PC are transferring a file.
If the camera status lamp blinks, you have to wait until the lamp illuminates.
2. Unplug the USB cable.
■ Windows 2000/ME/XP
(The illustrations may be different from the real display in accordance with the Windows O/S.)
1. Check whether the camera and PC are transferring a file.
If the camera status lamp blinks, you have to wait until the lamp illuminates.
2. Double-click the [Unplug or Eject Hardware] icon
on the task bar.
[Double-click!]

3. The [Unplug or Eject Hardware] window will
open. Select the [USB Mass Storage Device]
and click the [Stop] button.
[Click !]

4. The [Stop a Hardware device] window will open.
Select the [USB Mass Storage Device] and click
the [OK] button.
[Click !]

5. A [Safe to Remove Hardware] window will
open. Click the [OK] button.

[Click !]

《130》

Removing the removable disk
6. A [Unplug or Eject Hardware] window will open.
Click the [Close] button and the removable disk
will be removed safely.

7. Unplug the USB cable.

[Click !]

Setting up the USB Driver for MAC
1. A USB Driver for MAC is not included with the software CD as MAC OS supports the
camera driver.
2. Check the MAC OS. You can check the MAC OS version during MAC OS start-up.
This camera is compatible with MAC OS 9.2 ~ 10.3.
3. Connect the camera to the Macintosh and turn the camera power on.
4. A new icon will be displayed on the desktop after connecting the camera to the MAC.

Using the USB Driver for MAC
1. Double click a new icon on the desktop and the folder in the memory will be displayed.
2. Select an image file and copy or move it to MAC.

CAUTION
● For Mac OS 10.0 or later : First complete uploading from computer to camera and then
remove the removable disk with the Extract command.
●If a movie clip can’t play back on the Mac OS, please visit the following
site(http://www.divx.com/divx/mac/) and download the codec. Or, use a media player that
supports the Xvid codec (Mplayer, VLC(VideoLAN Client) media player).

《131》

Digimax Master
■ You can download, view, edit and save your images and movies with this software. This
software is only compatible with Windows except for the Windows 98.
■ To start the program, click [Start → Programs → Samsung → Digimax Master].

● Downloading images
1. Connect the camera to your PC.
2. A window for downloading images will display after
connecting the camera and your PC.
- To download the captured images, select the
[Select All(A)] button.
- Select desired folder in the window and click the
[Select All(A)] button. You can save captured
images and selected folder.
- If you click the [Cancel] button, downloading will be
cancelled.

[Click !]

3. Click [Next(N) >] button.

[Click !]
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Digimax Master
4. Select a destination and make a folder to save
downloaded images and folders.
- Folder names can be made in order of date and
images will be downloaded.
- Folder name will be made as you want and images
will be downloaded.
- After selecting a folder that was made before,
images will be downloaded.
5. Click [Next(N) >] button.

[Click !]

6. A window will open as shown alongside.
The destination of the selected folder will be
displayed on the upper side of the window.
Click the [Start] button to download the images.

[Click !]

7. Downloaded images will be displayed.
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Digimax Master
● Image viewer : You can view the stored images.

①

⑤
⑥
⑦

②

③
④

- Image viewer functions are listed below.
① Menu bar : You can select menus.
File, Edit, View, Tools, Change functions, Auto download, help, etc.
② Image selection window : You can select the desired images in this window.
③ Media type selection menu : You can select image viewer, image edit and movie edit
functions in this menu.
④ Preview window : You can preview a image or a movie clip and check the multi media
information.
⑤ Zoom bar : You can change preview size.
⑥ Folder display window : You can see the folder location of the selected image.
⑦ Image display window : Images of the selected folder are displayed.

※ Refer to the [Help] menu in Digimax Master for further information.
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Digimax Master
● Image edit : You can edit the still image.

①

④

②

③

- Image edit functions are listed below.
① Edit menu : You can select the following menus.
[Tools]
: You can resize or crop the selected image. See the [Help] menu.
[Adjust] : You can modify image quality. See the [Help] menu.
[Retouch] : You can change image or insert effects on the image. See the [Help] menu.
② Drawing tools : Tools for editing an image.
③ Image display window : a selected image displays in this window.
④ Preview window : You can preview the changed image.

※ A still image edited with Digimax Master can’t be played back on the camera.
※ Refer to the [Help] menu in Digimax Master for further information.
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● Movie edit : You can get the still image, movie clip, narration, music files together in a movie clip.

①

②

- Movie clip edit functions are listed below.
① Edit menu : You can select the following menus.
[Add Media] : You can add other media elements to a movie.
[Edit Clip] : You can change the brightness, contrast, colour and saturation.
[Effects]
: You can insert an effect.
[Set Text] : You can insert texts.
[Narrate] : You can insert a narration.
[Produce] : You can save the edited multi media as a new file name.
Frame display window : You can insert multi media in this window. You can
select AVI, Windows media (wmv), Windows media (asf) and movie clip for
this camera (avi, MPEG-4) file types.
② Frame display window : You can insert multi media in this window.

※ Some movie clips that was compressed with a codec that is not compatible with the Digimax
Master can’t play back in the Digimax Master.
※ Refer to the [Help] menu in Digimax Master for further information.
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ㆍMovies for viewing on the camera : You can play back a movie on this camera
1. Select a movie for playing back on the camera by pressing the [Add] button.
Insert effects and edit the movie. To save the edited movie, press the [Make] button.
2. Select [Movie for camera] video type.

3. Select Camera option, Output location, File name and press the [Make] button.
- Frame size : Selecting the width and height of the frame.
- Frame rate : Selecting the frame rate per second.
- File location : Selecting a location where the edited movie is saved.
- File name : To play back the movie on the camera, you must keep the DCF rule. Save
the movie as SV20XXXX.avi (You can input any numbers between 0001 ~
9999 instead of XXXX letters).
4. Connect the camera to the computer with the
included USB cable.
5. Copy the edited movie to [Removable
Disk\DCIM\XXXSSCAM].
(You can input any numbers between 100 ~ 999
instead of XXX letters)
6. You can play back the movie in the Play mode of the
camera.
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■ Digimax Reader is a Text recognition program. You can save an image file that is captured in
the Text mode, as a text file with this program. This software is only compatible with Windows.
■ To start the program, click [Start → Programs → Digimax Reader].
The following screen will appear.

■ How to use the Digimax Reader
1. Connect the camera and the PC with a USB cable and download the images that were
stored in the camera to the PC.
* Please see page 125~126 for details on Connecting a camera and PC, Downloading
images.
2. Run the Digimax Reader.
3. Click the Open(

) icon as shown alongside.

4. Select the image you want to save as a text file.
* Only an image that was taken with a SAMSUNG
camera can be opened.
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5. Click the Area Analysis(

) icon to scan the image.

6. Part of the image you selected will be displayed as
shown.

7. Click the Character Recognition(
) icon.
The part selected in the previous step will be
recognized as text.

8. To save the section as a text, click the Save(
)
icon. A window as shown alongside will be displayed.

9. Select the file type that you want.
Selectable file types : *.TXT, *.HWP, *.DOC, *.RTF

INFORMATION
● To get an image that can be recognised as a text :
- Keep a distance that you can capture the image clearly between the subject and the camera.
- The subject needs to be centered.
- Seek to avoid camera shake to get a good image.
● Refer to the [Help] menu in Digimax Reader for further information.
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■ Please check the following if the USB connection malfunctions.
[Case 1]

The camera power is off.
→ Turn the camera power on.

[Case 2]

USB Driver is not installed correctly.
→ Install the USB Driver correctly. Refer to page 115.

[Case 3]

The USB cable is not connected or you are using a cable with an incorrect
specification.
→ Use a USB cable with the correct specification.

[Case 4]

The camera is not recognized by your PC.
Sometimes, the camera may appear under [Unknown Devices] in Device
Manager.
→ Install the camera driver correctly.
Turn off the camera, remove the USB cable, plug in the USB cable again, and
then turn on the camera.

[Case 5]

There is an unexpected error during file transfer
→ Turn the camera power off and on again. Transfer the file again.

[Case 6]

How do I know my computer supports a USB Interface?
→ Check the USB port in your computer or keyboard.
→ Check the OS version. A USB Interface is available in Windows 98, 98SE, 2000,
ME .XP.
→ Check [Universal Serial Bus controllers] in Device Manager. Carry out the
following checks [Universal Serial Bus controllers].
Win 98/ME : Follow [Start → Settings → Control Panel → System → Device
Manager → Universal Serial Bus controllers].
Win 2000 : Follow [Start → Settings → Control Panel → System → Hardware
→ Device Manager → Universal Serial Bus controllers].
Win XP
: Follow [Start → Control Panel → Performance and Maintenance →
System → Hardware → Device Manager → Universal Serial Bus
controllers].
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There must be USB Host Controller and USB root hub under [Universal Serial
Bus controllers].
In addition, double-click on the USB Universal Host Controller and the USB Root
Hub to check if the Device Status states "This device is working properly".
If the Device Status says the device is "not working properly", click the "Driver" tab
and then click [Update Driver] or [Reinstall Driver].
→ When all the conditions mentioned above are met, the computer can support the
USB interface.

[Case 7]

When using the USB hub.
→ There may be a problem in connecting the camera to the PC through the USB
hub if the PC and the hub are not compatible. Wherever possible, connect the
camera to the PC directly.

[Case 8]

Are other USB cables connected to the PC?
→ The camera may malfunction when it is connected to the PC at the same time as
another USB cable. In this case, disconnect the other USB cable, and connect
only one USB cable to the camera.

[Case 9]

When I open the Device Manager (by clicking Start → (Settings) → Control Panel
→ (Performance and Maintenance) → System → (Hardware) → Device
Manager), there are Unknown Devices or Other Devices entries with a
yellow question mark(?) beside them or devices with an exclamation mark(!)
beside them.
→ Right-click on the entry with the question(?) or exclamation (!) mark and select
"Remove". Restart the PC and connect the camera the again. For Windows 98
PC, remove the camera driver also, restart the PC, and then reinstall the camera
driver.
→ Double-click on the entry with the question (?) or exclamation (!) mark, click the
"Driver" tab, and click [Update Driver] or [Reinstall Driver]. If a message appears
asking you to specify the location of the appropriate device driver, specify "USB
Driver" in the CD supplied.

[Case 10]

In some security programs (Norton Anti Virus, V3, etc.), the computer may not
recognize the camera as a removable disk.
→ Stop the security programs and connect the camera to the computer. Refer to the
security program instructions about how to stop the program.
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■ When the movie clip doesn’t play back on the PC
※ When the movie clip recorded by the camera doesn’t play back on the PC, the causes are
mostly due to the codec installed on the PC.
● When codec for play back the movie clip isn’t installed
→ Install the codec as listed below.
[Installing codec for Windows]
1) Insert the CD provided with the camera
2) Run the windows explorer and select [CD-ROM drive:\XviD] folder and click the XviD
codex-1[1].1.0.exe file.
[Installing codec for Mac OS]
1) Visit the following site for downloading the codec.http://www.divx.com/divx/mac
2) Click the [Free Download] button located at the upper right side of the page and a window
for downloading the DivX codec will display.
3) Select Mac OS you use and click the [Download] button. Save it on a folder you want to.
4) Run the downloaded file and the codec for playing back the movie clip will be installed.
※ If a movie clip can’t play back on the Mac OS, use a media player that supports XviD
codec (Mplayer, VLC(VideoLanClient)media player).

● When the DirectX 9.0 or later is not installed
→ Install the DirectX 9.0 or later
1) Insert the CD provided with the camera
2) Run the windows explorer and select the [CD-ROM drive:\ USB Driver\DirectX 9.0] folder
and click the DXSETUP.exe file.The DirectX will be installed. Visit the following site for
downloading the DirectX.http://www.microsoft.com/directx
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● If a PC (Windows 98) stops responding while the camera and PC are connected repeatedly
→ If a PC (Windows 98) is turned on for a long time and the camera is connected repeatedly,
the PC may not recognise the camera. In this case, re-start the PC.

● If a PC connected with the camera stops responding while Windows is starting.
→ In this case, disconnect the PC and the camera and Windows will start.
If the problem happens continuously, set the Legacy USB Support to disable and re-start
the PC. The Legacy USB Support is in the BIOS setup menu. (The BIOS setup menu
differs from the PC manufacturers and some BIOS menus don’t have Legacy USB
Support) If you can’t change the menu by yourself, contact to the PC manufacturer or
BIOS manufacturer.

● If the movie clip can’t be deleted, removable disk can’t be extracted or an error message
displays during the file transfer.
→ If you install only the Digimax Master, the problems mentioned above occasionally
happen.
- Close the Digimax Master program by clicking the Digimax Master icon on the Taskbar.
- Install all the application programs included in the software CD.
(You must install the Movie clip codec)

《143》

SAMSUNG TECHWIN CO., LTD.
OPTICS & DIGITAL IMAGING DIVISION
145-3, SANGDAEWON 1-DONG, JUNGWONGU,
SUNGNAM-CITY, KYUNGKI-DO, KOREA
462-121
TEL : (82) 31-740-8086,8088, 8090, 8092, 8099
FAX : (82) 31-740-8398, 8111
www.samsungcamera.com
SAMSUNG OPTO-ELECTRONICS AMERICA, INC.
HEADQUARTERS
40 SEAVIEW DRIVE, SECAUCUS, NJ07094, U.S.A.
TEL : (1) 201-902-0347
FAX : (1) 201-902-9342
WESTERN REGIONAL OFFICE
18600 BROADWICK ST.,
RANCHO DOMINGUEZ, CA 90220, U.S.A.
TEL : (1) 310-900-5263/5264
FAX : (1) 310-537-1566
www.samsungcamerausa.com
SAMSUNG OPTO-ELECTRONICS UK LIMITED
SAMSUNG HOUSE
1000 HILLSWOOD DRIVE
HILLSWOOD BUSINESS PARK
CHERTSEY KT16 OPS U.K.
TEL : 00800 12263727
(free for calls from UK only)
UK Service Hotline : 01932455320
www.samsungcamera.co.uk

SAMSUNG OPTO-ELECTRONICS GMBH
AM KRONBERGER HANG 6
D-65824 SCHWALBACH/TS., GERMANY
TEL : 49 (0) 6196 66 53 03
FAX : 49 (0) 6196 66 53 66
www.samsungcameras.de
SAMSUNG FRANCE S.A.S.
BP 51 TOUR MAINE MONTPARNASSE
33, AV .DU MAINE
75755, PARIS CEDEX 15, FRANCE
HOTLINE PHOTO NUMÉRIQUE :
00 800 22 26 37 27(Numéro Vert-Appel Gratuit)
TEL : (33) 1-4279-2200
FAX : (33) 1-4538-6858
www.samsungphoto.fr
SAMSUNG TECHWIN MOSCOW OFFICE
RUSSIA, 125167, MOSCOW LENNINGRADSKY,
PR-KT, 37-A, KORP14
TEL : (7) 095-258-9299/96/98
FAX : (7) 095-258-9297
http://www.samsungcamera.ru
TIANJIN SAMSUNG OPTO-ELECTRONICS CO.,LTD.
7 PINGCHANG ROAD NANKAI DIST., TIANJIN
P.R CHINA
POST CODE:300190
TEL : (86) 22-2761-4599
FAX : (86) 22-2769-7558
www.samsungcamera.com.cn

Internet address - http : //www.samsungcamera.com/
The CE Mark is a Directive conformity
mark of the European Community (EC)

6806-3015

